Welcome to the Epson Reference Guide

This software Reference Guide is your on-screen guide to your Epson Stylus CX3500 or CX4500 printer. By clicking the links on the left side of this screen, you can get information on the following topics.

Note:

Although the illustrations show the CX4500, the instructions apply to both models unless notes otherwise.

Printing

Explains how to print with this product.

Printer Software Introductions

Provides information on your printer software.

Scanning

Explains how to scan with this product.

Scanner Software Introductions

Provides information on your scanner software.

Replacing Ink Cartridges

Explains how to replace the ink cartridges.

Maintenance
Contains maintenance information.

**Troubleshooting**

Covers troubleshooting and customer support information.

**Product Information**

Contains technical specifications information.

---

**Copyrights and Trademarks**

**About Operating System Versions**

NPD0683-00
Glossary

additive primary colors
The colors of red, green and blue (RGB) - which give the perception of white when combined equally. These are the colors of the color system used by monitors and scanners.

application
A software program that helps you carry out a particular task, such as word processing or financial planning.

ASCII
American Standard Code for Information Interchange. A standardized coding system for assigning numerical codes to letters and symbols.

banding
The horizontal lines that sometimes appear when printing graphics. This occurs when the print head is misaligned.

bi-level data
Image data that is composed of 1 bit per pixel. A pixel is represented by a single bit of digital data that can be expressed as only 1 (light) or 0 (dark).

bit
A binary digit (0 or 1), which is the smallest unit of information used by a printer or computer.

bit/pixel
The unit that indicates the number of bits allocated for a pixel. The larger the bit value, the more detail of a pixel will be reproduced.

brightness
The lightness or darkness of an image.

buffer
The portion of the printer's memory used to store data before printing it.

byte
A unit of information consisting of eight bits.
**characters per inch (cpi)**
A measure of the size of text characters, sometimes referred to as pitch.

**CMYK**
Cyan (blue-green), magenta, yellow, and black. These colored inks are used to create the subtractive system array of printed colors.

**color correction**
A method of adjusting the color image data for a particular type of device so that the reproduction results are as close as possible to the original colors.

**color matching**
A method of processing color data so that colors displayed on a computer screen closely match colors in printouts. A variety of color-matching software is available. See also ColorSync.

**color separation**
A process of converting full-color images into a limited number of primary colors. Additive primary colors (red, green, and blue) are used by the scanner, and the subtractive primary colors (cyan, magenta, and yellow) plus black are used for printing press separation.

**color space**
A method that reproduces a specific color. Additive primary colors (red, green, and blue) are used by the scanner, and subtractive primary colors (cyan, magenta, and yellow) plus black are used for printing press separation.

**ColorSync**
Macintosh software that is designed to help you get WYSIWIG (what you see is what you get) color output. This software prints colors as you see them on your screen.

**cpi**
See characters per inch (cpi).

**default**
A value or setting that takes effect when the equipment is turned on, reset, or initialized.

**dithering**
A halftoning method in which dots are arranged in an orderly pattern. Dithering works best for printing images with solid colors, such as charts and graphs.
document
The item, such as a sheet of paper or a book, that is placed on the document table to read.

dpi
Dots per inch. The dpi measures the resolution. See also resolution.

drive
A storage device, such as CD-ROM, hard disk, or floppy disk. In Windows, a letter is assigned to each drive for easy management.

driver
A software program that sends instructions to a computer peripheral to tell it what to do. For example, your printer driver accepts print data from your word processor application and sends instructions to the printer on how to print this data.

dropout color
A color the scanner does not recognize and ignores. You can select and deselected dropout colors in the scanner software.

DTP
Desktop Publishing system, a system that enables you to edit a publication on a computer.

economy printing
Printing in which images are printed with fewer dots to save ink.

ESC/I
Abbreviation for EPSON Standard Code for image scanners. A system of commands that allows you to control image scanners from your software.

ESC/P
Abbreviation for EPSON Standard Code for printers, the system of commands your computer uses to control your printer. It is standard for all Epson printers and supported by most application software for personal computers.

exposure
A scanner function that lightens or darkens the scanned image data.

font
A style of type designated by a family name.
**gamma**
Gamma is a value that expresses the relationship between the input and output of a device. By adjusting the gamma, the brightness of the mid-tones of an image can be changed without affecting the shadows and highlights.

**grayscale**
A scale of shades of gray from black to white. Grayscale is used to represent colors when printing with black ink only.

**high speed printing**
Printing in which images are printed in both directions. This provides faster printing.

**ICM**
Image Color Matching. Windows color management system designed to help you get WYSIWYG (what you see is what you get) color output. This software displays colors on your screen as they exist on the scanned documents, or prints colors as you see them on your screen.

**initialization**
Returns the printer to its defaults (fixed set of conditions). This happens every time you turn on or reset this product.

**ink cartridge**
Contains the ink this product uses when printing.

**ink jet**
A method of printing in which each letter or symbol is formed by precisely spraying ink onto paper.

**interface**
The connection between the computer and this product. A parallel interface transmits data one character or code at a time. A serial interface transmits data one bit at a time.

**interface cable**
The cable that connects the computer and this product.

**local printer**
The printer connected to the computer's port directly by interface cable.

**marquee**
A moveable and adjustable frame that marks the area of an image that will be previewed or
media
Materials upon which data is printed, such as envelopes, plain paper, special paper.

memory
The part of the printer’s electronic system that is used to store information (data). Some information is fixed and is used to control how this product operates. Information that is sent to this product from the computer is stored in memory temporary. See also RAM and ROM.

moiré
A moiré is a cross-hatch pattern that appears on scanned images when scanning printed material. It is a result of interference that occurs due to the difference between the pitches of the scanning and the halftone screens.

monochrome
This means printing with only one color of ink, which is generally black ink.

nozzle
Fine tubes in the print head through which ink is sprayed on the page. Print quality may decline if the print head nozzles are clogged.

operation check
A method for checking the operation of this product. When you perform an operation check, this product prints the ROM version, code page, ink counter code, and a nozzle check pattern.

page sequence
The type of color scanning in which the entire image is scanned once for each separate color.

pixel
Short for picture element. Each image is composed of a number of pixels. Pixels are also counted in units of dots.

port
An interface channel through which data is transmitted between devices.

primary colors
Basic colors. See additive primary colors and subtractive primary colors.

printable area
The area of a page on which this product can print. It is smaller than the physical size of the page due to margins.

**printer driver**
A software program that sends commands for using the features of this product. Often shortened to "driver".

**print queue**
If this product is connected to a network, print jobs that are sent to this product while it is busy are stored in a waiting line, or print queue, until they can be printed.

**RAM**
Random Access Memory. The portion of this product's memory used as a buffer and for storing user-defined characters. All data stored in RAM is lost when this product is turned off.

**reset**
To return this product to its defaults by turning this product off and then back on.

**resolution**
The number of dots per inch used to represent an image.

**ROM**
Read Only Memory. A portion of memory that can only be read and cannot be used for data storage. ROM retains its contents when you turn off this product.

**RGB**
Red, green, and blue. These colors, in phosphors irradiated by the computer monitor's electron gun, are used to create the additive array of screen colors.

**scan**
An operation performed by the sensor and the carriage. The image is divided into pixels by scanning.

**scanning area**
The physical size of the image that can be scanned by this product.

**spool**
The first step in printing, in which the printer driver converts the print data into codes that your printer understands. This data is then sent to the printer directly or to the print server.
spool manager
The software program that converts print data into codes that this product understands. See also spool.

sRGB
A standard color space used as the default color space within the Windows 98 color management system (ICM 2.0).

status monitor
The software program that allows you to check this product's status.

subtractive colors
Colors produced by pigments that absorb some colors of light and reflect others. See also CMYK.

subtractive primary colors
The colors of cyan, magenta, and yellow (CMY) which produce black when mixed in certain amounts. In printing, black is often added to give more definition as mixing of actual inks cannot produce pure black.

threshold
A reference point that is used to determine whether data will be processed as "on" or "off". In the case of color image data, "on" means that a certain color will appear in a pixel or dot, and "off" means that color will not appear there.

tone correction
A method of adjusting the tone curve so that the reproduction results on different types of output devices have gradations similar to the original image.

tone curve
The graph that shows the contrast ratio between the input (original image) and output (image data) in image processing.

unsharp mask
Originally a photographic process in which a sharply focussed and a slightly out-of-focus image are combined to produce a sharper image. This process is simulated by software to produce the same effect.

USB interface
Universal Serial Bus interface. Enables the user to connect up to 127 peripheral devices (such as
keyboards, mice, and printers) to the computer through a single, general purpose port. The use of USB hubs allows you to add additional ports. See also interface.

**WYSIWYG**

What-you-see-is-what-you-get. This term is used to describe printout that looks exactly like it appears on screen.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

- Ink Cartridges
- Checking the Ink Supply
- Precautions on Ink Cartridge Replacement
- Replacing an Empty Ink Cartridge
- Replacing an Ink Cartridge

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

• Diagnosing the Problem
• Print Head Carriage Problem
• Correcting USB Problems
• Printing and Copying Problems
• Scanning Problems
• Customer Support

Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information

- Parts
- Control Panel Functions
- Consumable Products
- Exif Print
- Using Memory Card
- Product Specifications
Copyrights and Trademarks

Copyrights

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

EPSON® is a registered trademark and EPSON Stylus™ is a trademark of Seiko Epson Corporation.

Copyright 2001 Seiko Epson Corporation. All rights reserved. PRINT Image Matching™ is a trademark of Seiko Epson Corporation. The PRINT Image Matching logo is a trademark of Seiko Epson Corporation.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.

Apple® and Macintosh® are registered trademarks of Apple Computer, Inc.
DPOF™ is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo Film Co., Ltd. and Matsushita Electric Industrial Co., Ltd.

SD™ is a trademark.

Memory Stick, Memory Stick Duo, Memory Stick PRO, and Memory Stick PRO Duo are trademarks of Sony Corporation.

xD-Picture Card™ is a trademark of Fuji Photo Film Co., Ltd.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

Copyright © 2004 by Seiko Epson Corporation, Nagano, Japan.
About Operating System Versions

In this manual, Windows indicates Windows XP, Me, 98 SE, or 2000.

Mac OS 9 indicates Mac OS 9.1 or later.

Mac OS X indicates Mac OS X 10.2 to 10.3.
How to Print
  - Introduction
  - Printing Text and Web Pages
  - Printing Photos
  - Printing on Envelopes

Basic Printing Information

Various Printing Options

Other Information

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

How to Print

Basic Printing Information
- Loading Single Sheets of Paper
- Using Special Media
- Loading Envelopes
- Media Type Settings
- Making User Defined Paper Sizes

Various Printing Options

Other Information

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

- How to Print
- Basic Printing Information
- Various Printing Options
  - Introduction to Various Printing Options
  - Borderless Printing
  - Double-Sided Printing
  - Fit to Page Printing
  - Pages Per Sheet Printing
  - Poster Printing
  - Watermark Printing
- Other Information

  Printer Software Introductions

Scanning

  Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Introduction

Printer Software

Accessing the Printer Software

Getting Information Through Online Help

Printer Software

The printer software that comes with this product includes a printer driver and printer utilities. The printer driver lets you choose from a wide variety of settings to get the best results from this product. The printer utilities help you check the printer and keep it in top operating condition.

Accessing the Printer Software

For information on accessing the printer software, refer to the appropriate section below.

Accessing the Printer Software for Windows

Accessing the Printer Software for Mac OS 9

Accessing the Printer Software for Mac OS X

Note for Windows users:

The specific features available in the printer software vary depending on the version of Windows that you are using.
Getting Information Through Online Help

Your printer software has an extensive online help feature that provides you with instructions on printing, making printer driver settings, and using printer utilities.

Refer to the appropriate section below.

Getting Information Through Online Help for Windows

Getting Information Through Online Help for Mac OS 9

Getting Information Through Online Help for Mac OS X
Printing

Printer Software Introductions

- Introduction
- Accessing the Printer Software
- Getting Information
  - Getting Information Through Online Help for Windows
  - Getting Information Through Online Help for Mac OS 9
  - Getting Information Through Online Help for Mac OS X

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

How to Scan
- Overview of the Basic Procedure
- Scanning an Image
- Placing Photos and Documents on the Document Table

Various Scanning Options

Using EPSON Smart Panel

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Printing

Printer Software Introductions

Scanning

How to Scan

Various Scanning Options
  • Choosing an Appropriate Scanning Mode
  • Making Suitable Settings
  • Creating Beautiful Reproductions
  • Scanning Multiple Images Simultaneously
  • Scanning Documents to Convert to Text Data (OCR)
  • Starting Scanner Software (EPSON Scan) Directly
  • Using the Preview Window in EPSON Scan

Using EPSON Smart Panel

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information
Scanner Software Introductions

EPSON Scan

TWAIN-compliant Applications

This product is controlled by your computer via a TWAIN-compliant driver called EPSON Scan.

EPSON Scan directly controls all of the features of this product. With this software you can scan images in color, grayscale, or black and white and obtain professional quality results. This program is the standard cross-platform interface between this product and most applications. You can access it from any application that supports the TWAIN standard.

Note for Mac OS X users:

Depending on your application, you may not be able to access EPSON Scan from the application.

TWAIN

TWAIN is a standard for the application program interface (API) between image input devices (such as scanners) and applications which control the image input devices.

Using a TWAIN-compliant application and a TWAIN-compliant scanner with a TWAIN-compliant driver enables users to operate any scanner in the same manner.

TWAIN-compliant Applications

This product is a TWAIN-compliant device. You can scan images using a TWAIN-compliant image processing application.

EPSON Smart Panel is a TWAIN-compliant image processing application that is included in this product's package. We recommend that you use this software.

You can also scan images using common TWAIN-compliant applications such as Adobe Photoshop.

While in a TWAIN-compliant application, when you select a scan command to scan an image, EPSON Scan starts and scans the image with the specified settings.
While the TWAIN-compliant application may appear to be controlling this product in the scanning process, it is EPSON Scan which is actually doing the job.

You can use the EPSON Scan screen to specify various settings for scanning.

**Note:**

You can operate EPSON Scan in the same way on both Windows and Macintosh. This guide explains the operation procedure using Windows examples.
Starting EPSON Scan

When using EPSON Scan as a stand alone application
When using the EPSON Smart Panel software
When using a TWAIN-compliant application

You can start EPSON Scan in three ways. Depending on your scanning purpose, use the starting method creatively.

When using EPSON Scan as a stand alone application

If you just want to save scanned images without editing them, start EPSON Scan directly. Scanned images are automatically saved as files in the specified folder. For more details, see Starting Scanner Software (EPSON Scan) Directly.

For Windows users

Click Start, point to All Programs (for Windows XP users) or Programs (for Windows Me, 98, and 2000 users) and EPSON Scan, and then select EPSON Scan. The File Save Settings dialog box appears.
Note:

If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the Scan button, and then select File Save Settings.

Click OK. EPSON Scan starts.

For users of Mac OS 9

Select EPSON Scan from the Apple menu. The File Save Settings dialog box appears.
Note:
If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the **Scan** button, and then select **File Save Settings**.

For Mac OS X users

Click the **EPSON Scan** icon in the **Applications** folder. The File Save Settings dialog box appears.

Note:
If you finished scanning in the Home Mode or the Professional Mode last time, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the small arrow to the right of the **Scan** button, and then select **File Save Settings**.

When using the EPSON Smart Panel software

EPSON Smart Panel allows you to scan and send data directly to an assigned application, or the EPSON photo-sharing website. When you want to obtain photos and documents in digital form quickly and easily, start EPSON Scan by using the EPSON Smart Panel.
For more information on EPSON Smart Panel, see Overview of EPSON Smart Panel.

When using a TWAIN-compliant application

Note for Mac OS X users:
Depending on your application, you may not able to start EPSON Scan as described here.

When using a TWAIN-compliant application, such as Adobe Photoshop, you can scan images directly into the application. For details, see the manual provided with your application.

[Top]
Getting Information Through Online Help

EPSON Scan includes an extensive online help which gives you instructions on scanning and making driver settings.

Click the help icon in any of the dialog boxes in EPSON Scan.
Replacing Ink Cartridges

**Ink Cartridges**

You can use the following cartridges with this product.

<table>
<thead>
<tr>
<th>Black ink cartridge</th>
<th>Black</th>
<th>T044120</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color ink cartridge</td>
<td>Cyan, Magenta, Yellow</td>
<td>T044220 T044320 T044420</td>
</tr>
</tbody>
</table>

**Caution:**

Epson recommends the use of genuine Epson ink cartridges. Epson will not warranty any damage caused by the use of other products.
Checking the Ink Supply

For Windows

You can check the amount of ink remaining in the ink cartridges using EPSON Status Monitor 3 or the progress meter. Refer to the appropriate section below for details.

EPSON Status Monitor 3

Access EPSON Status Monitor 3 in one of the following ways.

- Double-click the printer-shaped shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see online help for details.

- Open the printer software, click the Maintenance tab, then click the EPSON Status Monitor 3 button.

A graphic displaying the amount of ink remaining will appear.
Note:

If any of the ink cartridges installed in this product is broken, incompatible with the printer model, or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status Monitor 3.

Progress meter

The progress meter dialog box appears automatically when you send a print job to this product. You can check the remaining amount of ink from this dialog box.
For Macintosh

You can check the amount of ink remaining in the ink cartridges using EPSON StatusMonitor. Follow the steps below.

For Mac OS 9

1. Access the Print or Page Setup dialog box

   Accessing the Printer Software for Mac OS 9

2. Click the Utility icon button, then click the EPSON StatusMonitor button in the Utility dialog box.

A graphic displaying the amount of ink remaining will appear.
Note:

- The graphic displays the amount of ink that was remaining when EPSON StatusMonitor was first opened. To update the ink-level information, click Update.

- If any one of the ink cartridges that are installed in this product is broken, incompatible to the printer model, or is installed improperly, the EPSON StatusMonitor will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge when indicated by the EPSON StatusMonitor.
Double-click **Macintosh HD** (the default hard disk name), double-click the **Applications** folder, then double-click the **EPSON Printer Utility** icon. The Printer List window appears.

Select this product, then click **OK**. The EPSON Printer Utility dialog box appears.

Click the **EPSON StatusMonitor** button. The EPSON StatusMonitor dialog box appears.

**Note:**
- The graphic displays the amount of ink that remained when EPSON StatusMonitor was first opened. To update the ink-level information, click **Update**.
If any one of the ink cartridges that are installed in this product is broken, incompatible to the printer model, or is installed improperly, the EPSON StatusMonitor will not display an accurate calculation for the amount of ink remaining in any of the ink cartridges. Be sure to replace or reinstall any ink cartridge when indicated by the EPSON StatusMonitor.
Precautions on Ink Cartridge Replacement

Read all of the instructions in this section and "Safety Instructions" by clicking Safety "Safety" before replacing the ink cartridges.

- If you need to remove an ink cartridge temporarily from this product, be sure to protect the ink supply area of the ink cartridge from dirt and dust. Store the ink cartridge in the same environment as this product. When storing the cartridge, be sure that its label identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.

- The valve in the ink supply port is designed to contain any excess ink that may be released. However, careful handling is recommended. Do not touch the supply port of the ink cartridge or its surrounding area.

- This product uses ink cartridges equipped with an IC chip. The IC chip accurately monitors the amount of ink used by each cartridge, so even if a cartridge is removed and then later inserted again, all of its ink can be used. However, some ink is consumed each time the cartridge is inserted because this product automatically checks its reliability.

- When an ink cartridge becomes empty, you cannot continue copying nor printing even if the other cartridge still contains ink. Before copying or printing, replace the empty cartridge.

- In addition to being used in document copying, ink is also consumed during the following operations: print head cleaning, self-cleaning cycle performed when this product is turned on, and ink charging when an ink cartridge is installed in this product.

- Do not refill the ink cartridges. This product calculates the amount of ink remaining using an IC chip built into the ink cartridge. Even if the cartridge is refilled, the amount of ink remaining is not recalculated by the IC chip and therefore the amount of ink available for use does not change.

- After an ink cartridge is replaced, if the ink is low it may become empty. When a message appears to indicate the ink is low, have a new ink cartridge ready.
Replacing an Empty Ink Cartridge

- Using the Control Panel
- Using the EPSON Status Monitor

You can replace ink cartridges using the Control Panel or using the Status Monitor utility. Refer to the appropriate section.

**Note:**
Before replacing, read "Safety Instructions" by clicking Safety and Precautions on Ink Cartridge Replacement.

**Using the Control Panel**

To replace an ink cartridge using the Ink button, follow the steps below.

**Note:**
The illustrations show replacement of the cyan ink cartridge. Replace the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The On light should be on, but not flashing.
2. Make sure that the document cover is closed, and then open the scanner unit.

**Caution:**
Do not open the scanner unit when the document cover is still open.
Press the Ink button. The print head moves to the ink cartridge check position and the On light and the Ink light begins to flash. The ink cartridge indicated by the mark is either empty or low.

**Note:**
Do not press the Ink button for more than three seconds. Otherwise the printer starts cleaning the print head.

**Caution:**
Do not move the print head by hand, as this may damage this product. Always press the Ink button to move it.

Press the Ink button.
If more than one ink cartridge is empty or low, the print head moves so that the empty or low ink cartridge is indicated by the mark. This occurs each time the Ink button is pressed until all empty or low ink cartridges have been indicated.
Once all of the empty or low ink cartridges have been indicated, the print head moves to the ink cartridge replacement position when the Ink button is pressed.
For best results, shake the ink cartridge four or five times before opening the package.

Remove the new ink cartridge from the package.

Open the cartridge cover. Pinch the sides of the ink cartridge that you want to replace. Lift the cartridge out of the printer and dispose of it properly. Do not take the used cartridge apart or try to refill it.
**Warning:**

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately.

Place the replacement ink cartridge vertically into the cartridge holder, then push the ink cartridge down until it clicks into place.

When you have finished replacing the ink cartridge, close the cartridge cover and press it so that it clicks into place. Then close scanner unit.
Press the Ink button.

The product begins charging the ink delivery system. This process takes about one minute to complete. When the ink charging process is finished, the On light stops flashing and remains lit, and the Ink light goes out.

Caution:

The On light continues to flash while this product performs the ink charging operation. Never turn off this product while this light is flashing. Doing so can result in incomplete charging of ink.

Note:

If the Ink light remains on after the On light stops flashing (and remains lit), the ink cartridge may not be installed correctly. Press the Ink button again, and reinstall the ink cartridge until it clicks into place.

Using the EPSON Status Monitor

You can monitor the remaining ink levels from your computer and view on-screen instructions for
replacing a low or empty ink cartridge using EPSON Status Monitor 3 (Windows) or EPSON StatusMonitor (Macintosh).

When an ink cartridge is low or empty, click How to in the EPSON Status Monitor window. Follow the on-screen instructions to replace the cartridge.

**Conserving black ink when the cartridge is low**

The dialog box below appears when black ink becomes low and the following conditions exist:

- **Plain Paper/Bright White Paper** is selected as the paper type, and **Text and Image** is selected as the Quality Option.

- There is more color ink than black ink.

- The black ink cartridge is not empty.

- The color ink cartridges are not low.

The dialog box gives you the option to either continue using black ink normally or conserve black ink by using a mixture of color inks to create black.

By clicking the **Yes** button, you can use a mixture of color inks to create black for printing documents. Ink from the black ink cartridge is not used. In some cases, the black created by combining inks may differ slightly from that of the black ink cartridge. The dialog box appears the next time you print a job that uses black ink and again gives you the option to conserve black ink.

By clicking the **No** button, you can continue using the remaining black ink for the job you are printing. The dialog box appears the next time you print a job that uses black ink and again gives you the option to conserve black ink.
By clicking the **Disable this feature** button, you can continue using black ink normally. The dialog box does not appear again for the remaining life of the black ink cartridge. In this case, black ink is used normally until it runs out completely.
Replacing Ink Cartridges

Replacing an Ink Cartridge

- Using the Control Panel
- Using the Ink Cartridge Replacement Utilities (for Windows)

In some circumstances, you may need to replace an ink cartridge before it is empty.

You can replace an ink cartridge using the control panel or using the Ink Cartridge Replacement utilities (for Windows).

Using the Control Panel

To replace an ink cartridge using the Ink button, follow the steps below.

Note:

The illustrations show replacement of the cyan ink cartridge. Replace the ink cartridge appropriate to your situation.

1. Make sure that the printer is on. The On light should be on, but not flashing.

2. Make sure that the document cover is closed, and then open the scanner unit.

Caution:

Do not open the scanner unit when the document cover is still open.

3. Press the Ink button. The print head moves to the ink cartridge replacement position.
Note:

Do not press the Ink button for more than three seconds. Otherwise the printer starts cleaning the print head.

Caution:

Do not move the print head by hand, as this may damage this product. Always press the Ink button to move it.

For best results, shake the ink cartridge four or five times before opening the package.

Remove the new ink cartridge from the package.
Open the cartridge cover. Pinch the sides of the ink cartridge that you want to replace. Lift the cartridge out of the printer and dispose of it properly. Do not take the used cartridge apart or try to refill it.

**Warning:**

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately.

Place the replacement ink cartridge vertically into the cartridge holder, then push the ink cartridge down until it clicks into place.
When you have finished replacing the ink cartridge, close the cartridge cover and press it so that it clicks into place. Then close scanner unit.

Press the Ink button.

The product begins charging the ink delivery system. This process takes about one minute to complete. When the ink charging process is finished, The On light stops flashing and remains lit, and the Ink light goes out.
Caution:

The On light continues to flash while this product performs the ink charging operation. Never turn off this product while this light is flashing. Doing so can result in incomplete charging of ink.

Note:

If the Ink light remains on after the On light stops flashing (and remains lit), the ink cartridge may not be installed correctly. Press the Ink button again, and reinstall the ink cartridge until it clicks into place.

Using the Ink Cartridge Replacement Utilities (for Windows)

You can view on-screen instructions for replacing an ink cartridge using the Ink Cartridge Replacement utilities.

When you need to replace an ink cartridge before it is low or empty, click the button on the Maintenance tab.
Cleaning This Product

To keep this product operating at its best, clean it thoroughly several times a year.

1. Make sure this product is turned off and all of its lights are off. Then unplug the power cord.

2. Remove all paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt.

4. If the outer case or the inside of the sheet feeder is dirty, clean it with a soft, clean cloth dampened with mild detergent. Keep the document and scanner unit closed to prevent moisture from getting inside.

5. If the document table is dirty, open the document cover. Then clean the glass with a soft, clean and dry cloth, or with a blower brush.

6. If the inside of this product accidentally gets soiled with ink, wipe the ink away with a damp cloth.

Warning:

Be careful not to touch the internal gears.

Caution:

- Never use alcohols or thinners to clean this product; these chemicals can damage the components as well as the case.
- Be careful to keep water away from the printing and scanning mechanisms and electronic components.

- Do not use a hard or abrasive brush.

- Do not spray the inside of this product with lubricants; unsuitable oils can damage the mechanisms. Contact your dealer or a qualified service person if lubrication is needed.
Maintenance

Transporting This Product

If you need to transport this product, carefully repack it using the original box (or a similar box that this product fits snugly into) and packing materials as follows:

1. Remove all paper from the sheet feeder and make sure that this product is off.

2. Open the scanner unit and make sure that the print head is in the home position on the right. Secure the ink cartridges to this product with a tape, and then close the scanner unit.

3. Unplug the power cord from the electrical outlet and the USB cable from your computer if connected.

4. Close the paper support, feeder guard, and output tray.

Connecting and Disconnecting the USB Cable
Attach the protective materials to both sides of this product, and then repack this product and attachments in the box.

Keep this product on a flat surface to protect it from shocks during transportation.

**Note:**

Do not forget to remove the protective materials and tape from this product before using it again.
Connecting and Disconnecting the USB Cable

Disconnecting the USB cable from this product

1. Make sure this product is turned off and all of its lights are off.

2. Disconnect the USB cable from this product, as shown in the illustration below.

Connecting the USB cable to this product

1. Make sure this product is turned off and all of its lights are off.

2. Plug the USB cable connector (disconnected from this product earlier) into the USB port of this product.
Aligning the Print Head

Using the printer software
Using the control panel buttons

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem from your computer using the Print Head Alignment utility in your printer software or control panel.

Alignment patterns containing the following patches are printed in the process of aligning the print head.

Good

Not good

A good result is when the patches are the most evenly printed with no noticeable streaks or lines, as in the above illustration.

Refer to the appropriate section below for instructions on how to align the print head.

Note:

- Do not press the Stop button to cancel printing while printing an alignment pattern.

- Use the printer software to perform a more accurate print head alignment. Only use the control panel buttons to align the print head if you cannot use the printer software.

Using the printer software

For Windows
Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the □ position.

2. Make sure that this product is on and the Error light is off.

3. Access the printer software.

   Accessing the Printer Software for
   Windows

4. Click the **Maintenance** tab, then click the **Print Head Alignment** button.

5. Follow the on-screen instructions to align the print head.

**For Mac OS 9**

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the □ position.

2. Make sure that this product is on and the Error light is off.

3. Access the Print or Page Setup dialog box.

   Accessing the Printer Software for Mac OS
   9
Click the Utility icon button, then click the **Print Head Alignment** button.

Follow the on-screen instructions to align the print head.

**For Mac OS X**

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the position.

2. Make sure that this product is on and the Error light is off.

3. Access the EPSON Printer Utility dialog box.

   Accessing the Printer Software for Mac OS X

4. Click the **Print Head Alignment** button in the Utility dialog box.

5. Follow the on-screen instructions to align the print head.

**Using the control panel buttons**

Follow the steps below to align the print head using the Control Panel.

**Note:**
Do not press the Stop button to cancel printing while printing an alignment pattern.

1. Make sure that letter-size plain paper is loaded in the sheet feeder and that the adjust lever is set to the position.

2. Make sure that this product is turned off.

3. Press the On button while holding down the Copy button. Hold both buttons down until the On light begins to flash, then release them.

   The power comes on and the alignment pattern is printed.

4. After the alignment pattern has been printed, the Plain Paper light comes on. Look at the patches for alignment pattern #1 on the sheet and find the patch that is most evenly printed, with no noticeable streaks or lines. Press the Copy button until the number for that patch appears in the LED window.

   Finally, press the Start B&W button to enter your selection.

5. The Photo Paper light remains lit. As with the first alignment pattern, find the patch on alignment pattern #2 that is most evenly printed, with no noticeable streaks or lines, and then press the Copy button until the number for that patch appears in the LED window.

   Finally, press the Start B&W button to enter your selection.

6. The Letter light comes on. As with the other alignment patterns, find the patch on alignment pattern #3 that is most evenly printed, and press the Copy button until the number for that patch appears in the LED window. Then press the Start B&W button to enter your selection.

7. The 4x6 light comes on. As with the other alignment patterns, find the patch on alignment pattern #4 that is most evenly printed, and press the Copy button until the number for that patch appears in the LED window. Then press the Start B&W button to enter your selection.
All the lights on the product will light briefly, then the product will turn off. This completes the head alignment procedure.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

- Cleaning This Product
- Transporting This Product
- Connecting and Disconnecting the USB Cable
- Aligning the Print Head

Updating and Uninstalling Software

- Updating your OS
- Updating the Printer Software for Windows Me, XP, or 2000
- Uninstalling the Printer Software
- Uninstalling EPSON Scan
- Uninstalling the Reference Guide

Troubleshooting

Product Information
Troubleshooting

Diagnosing the Problem

- Lights on the Control Panel
- EPSON Status Monitor
- Running a printer operation check

If the product is connected via the USB interface and you are having difficulty printing, the problem may be related to your USB connection. Refer to Correcting USB Problems for details.

If your problem is not USB related, first diagnose the problem, then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by the online problem solving, the lights on the control panel, from the EPSON Status Utility, or by running a printer operation check. See the Quick Reference Guide for details on how to use the lights on the control panel to diagnose and solve hardware problems. See the remaining sections in this chapter for software related problems.

If you have a specific problem relating to print quality, a printout problem not related to print quality, or a paper feeding problem, or if this product does not print at all, refer to the appropriate section in this chapter.

To solve a problem, you may need to cancel printing. For details, see Canceling Printing.

Lights on the Control Panel

You can identify many common problems by referring to the status of the lights on the control panel. Refer to the Quick Reference Guide for details.

EPSON Status Monitor

The EPSON Status Monitor utility provides status messages and a graphic display showing the current status of this product.
If a problem occurs while printing, an error message appears in the Progress Meter window.

When the ink runs low or out, click the **How to** button in the EPSON Status Monitor or Progress Meter window and EPSON Status Monitor will lead you step-by-step through the cartridge replacement procedure.

If an error message indicating that parts inside this product are near the end of their service life appears, contact your dealer for replacement.

---

**Running a printer operation check**

If you are unable to determine the source of the problem, performing a printer operation check can help you determine whether the problem comes from this product or the computer.

Follow these steps.

1. Disconnect the USB cable from your computer.

2. Make sure that letter-size paper is loaded in the sheet feeder.

3. Press the On button while also pressing the Ink button.

This product prints an operation check page that includes a nozzle check pattern.

Compare the quality of the printed test page with the sample shown below. If there are no print quality problems, this product is fine and the problem probably lies with the printer software settings, the application settings, the interface cable (be sure to use a shielded cable), or the computer itself.

If the test page does not print satisfactorily, there is a problem with this product. For example, if bands appear in the check pattern as shown below, an ink nozzle may be clogged or the print head may be
misaligned. See "Cleaning the Print Head" in the Quick Reference Guide for details on cleaning the print head.
Troubleshooting

Print Head Carriage Problem

If the carriage cover does not close or the print head carriage does not move to its home position, open the carriage cover and push the ink cartridges down until they click into place.
Troubleshooting

Correcting USB Problems

- USB connections
- Windows operating system
- Printer software installation
- Scanner software installation

If you are having difficulty using this product with a USB connection, see if one of the solutions listed below solves the problem.

USB connections

USB cables or connections can sometimes be the source of USB problems. Try one or both of these solutions:

- Use a USB cable that meets the specifications for the USB interface of this product. See USB Interface for details.

- For best results, you should connect this product directly to the computer's USB port. If you must use multiple USB hubs, we recommend that you connect this product to the first-tier hub.

Windows operating system

Your computer must be a Windows Me, 98, XP, or 2000 pre-installed model, or a Windows 98 pre-installed model that was upgraded to Windows Me. You may not be able to install or run the USB printer driver on a computer that does not meet these specifications, or that is not equipped with a built-in USB port.

For details about your computer, contact your dealer.
**Printer software installation**

Incorrect or incomplete software installation can lead to USB problems. Take note of the following, and perform the recommended checks to ensure proper installation.

**Checking printer software installation for Windows XP and 2000**

When using Windows XP or 2000, you must follow the steps in the Setup Sheet packed with this product to install the printer software. Otherwise, Microsoft's Universal driver may be installed instead. To check if the Universal driver has been installed follow the steps below.

1. Open the **Printers** folder and right-click the icon for this product.

2. Click **Printing Preference** on the shortcut menu that appears, then right-click anywhere in the driver.

   If **About** is displayed in the shortcut menu that appears, click it. If a message box with the words "Unidrv Printer Driver" appears, you must reinstall the printer software as described in the Setup Sheet. If **About** is not displayed, the printer software has been installed correctly.

**Note:**

If the Digital Signature Not Found (Windows 2000) or Software Installation dialog box (Windows XP) appears during the installation process, click **Yes** (Windows 2000) or **Continue Anyway** (Windows XP). If you click **No** (Windows 2000) or **STOP Installation** (Windows XP), you will have to install the printer software again.

**Checking printer software for Windows Me and 98**

If you canceled the plug-and-play driver installation in Windows Me or 98 before the procedure was complete, the USB printer device driver or the printer software may be incorrectly installed. Follow the directions below to ensure that the driver and printer software are installed correctly.

**Note:**

The screens shown in this section are for Windows 98. Windows Me screens may differ slightly.
Click **Start**, point to **Settings**, and click **Printers**. Make sure that the icon for this product appears in the Printers window.

Select the icon for this product, then click **Properties** on the File menu.

Click the **Details** tab.

If **EPUSBX: (EPSON Stylus CX3500 or EPSON Stylus CX4500)** is displayed in the **Print to the following port** list box, then the USB printer device driver and printer software is installed correctly. If the correct port is not displayed, proceed to the next step.
Right-click the **My Computer** icon on your desktop, then click **Properties**.

Click the **Device Manager** tab.

If your drivers are correctly installed, EPSON USB Printer Devices should appear on the Device Manager menu.

If EPSON USB Printer Devices does not appear on the Device Manager menu, click the plus (+) sign beside Other devices to view the installed devices.
If USB MFP or EPSON Stylus CX3500 or EPSON Stylus CX4500 appears under Other devices, the printer software is not installed correctly. Proceed to step 5.

If neither USB MFP nor EPSON Stylus CX3500 or EPSON Stylus CX4500 appears under Other devices, click Refresh or unplug the USB cable from this product, then plug it into this product again. Once you have confirmed that these items appear, proceed to step 5.

Under Other devices, select USB MFP or EPSON Stylus CX3500 or CX4500 and click Remove. Then, click OK.

When the following dialog box appears, click OK, then click OK to close the System Properties dialog box.
Uninstall the printer software as explained in Uninstalling the Printer Software. Then turn off this product, restart your computer, and reinstall the printer software as explained on the Start Here sheet packed with this product.

Scanner software installation

If you canceled the scanner software installation before the procedure was completed, or you connected this product before installing the software, EPSON Scan may be incorrectly installed.

Follow these steps to install the software correctly.

1. Disconnect the USB cable from your computer.

2. Reinstall the software as described on the Start Here sheet.
Troubleshooting

- Diagnosing the Problem
- Print Head Carriage Problem
- Correcting USB Problems

Printing and Copying Problems
  - Print Quality Problems
  - Printout Problems Not Related to Print Quality
  - Paper Does Not Feed Correctly
  - This Product Does Not Print
  - Canceling Printing

Scanning Problems

Customer Support

Product Information
Troubleshooting
- Diagnosing the Problem
- Print Head Carriage Problem
- Correcting USB Problems
- Printing and Copying Problems
- Scanning Problems
  - Scanner Operation Problems
  - Software Operation Problems
  - Quality Problems
  - Color Matching Problems
- Customer Support
- Product Information
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

- Diagnosing the Problem
- Print Head Carriage Problem
- Correcting USB Problems
- Printing and Copying Problems
- Scanning Problems
- Customer Support
  - Technical Support Web Site
  - Contacting Customer Support

Product Information
Parts

a. Edge guide: Helps load the paper straight. Adjust the left edge guide to fit the width of your paper.

b. Sheet feeder: Feeds a stack of paper automatically.


d. Paper support: Supports the paper loaded in the paper feeder.

e. Feeder guard: Prevents the objects which you place on the document cover from falling inside this product when opening the document cover.

f. Document cover: Open and close when you place a photo or document.

g. Output tray: Receives ejected paper.

h. Output tray extension: Supports the ejected paper.

i Memory card slot cover: Open the cover to inset or eject the memory card.
j. Scanner unit: Open and close when you replace an ink cartridge.

k. On button: Turns this product on and off.

a. Cartridge cover: Hold the ink cartridge in place.

b. Adjust lever: Adjusts the distance between the print head and the paper to prevent smearing. Adjust the lever to the position if ink appears to smear across your document when printing on thick paper or envelopes.
a. Document table: Place originals face-down on the glass.

b. Memory card slots: Use to load a memory card.

c. Control Panel: See Control Panel Functions for details on panel operation.

a. USB cable connector: Connect this product with your computer.

b. AC inlet: Connect the power cord.
Product Information

Control Panel Functions

- Buttons
- Lights

CX3500

CX4500
## Buttons

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 On</td>
<td>Turns this product on and off.</td>
</tr>
<tr>
<td>🔄</td>
<td>Moves the print head to the ink check position when an ink cartridge that is empty or nearly empty is detected.</td>
</tr>
<tr>
<td></td>
<td>Moves the print head to the ink cartridge replacement position.</td>
</tr>
<tr>
<td></td>
<td>Returns the print head to its home position after ink cartridge replacement.</td>
</tr>
<tr>
<td></td>
<td>Performs print head cleaning if held down for three seconds when the ink light is off.</td>
</tr>
<tr>
<td>Memory Card (CX4500 only)</td>
<td>Enters the Memory Card mode and selects the memory card print options:</td>
</tr>
<tr>
<td></td>
<td>Print Index Sheet: This is selected when you press the button and the paper type and size are set to Plain Paper and Letter.</td>
</tr>
<tr>
<td></td>
<td>Print From Index Sheet: This is selected automatically after printing the index sheet for a memory card. Press the button repeatedly until this option is selected if you are printing an image from index sheets that were printed previously.</td>
</tr>
<tr>
<td></td>
<td>Print All/DPOF: Select this option to print all the images on a memory card or to print images using the DPOF information stored on the memory card. If a memory card containing DPOF information is inserted into a memory card slot, Print All/DPOF is automatically selected when you press the Memory Card button.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy</td>
<td>Enters Copy mode and allows you to set the number of copies. The number of copies increases by one every time you press this button. The number of copies is displayed in the LED window. If you press this button when 9 is displayed as the number of copies, &quot;-&quot; appears in the LED window. This indicates that up to 100 copies will be made. To make between 10 and 100 copies, make sure that &quot;,&quot; is displayed, then insert the same amount of sheets in the feeder as the number of copies you want made. 1 appears in the LED window if this button is pressed when &quot;,&quot; is displayed.</td>
</tr>
<tr>
<td>Plain Paper / Photo Paper</td>
<td>Selects Plain Paper or Photo Paper as the paper type. Select Plain Paper when using plain paper or recycled paper. Select Photo Paper when using DURABright Photo Paper.</td>
</tr>
<tr>
<td>Letter / 4&quot; x 6&quot;</td>
<td>Selects Letter or 4&quot; x 6&quot; as the size of the paper loaded in the sheet feeder. You can copy only on letter-size or 4x6-inch size paper when using the control panel.</td>
</tr>
<tr>
<td>Fit to Page</td>
<td>Reduces or enlarges the size of the copy so that the scanned image fits on the selected size of paper.</td>
</tr>
<tr>
<td>✨ Start B&amp;W</td>
<td>Copies in grayscale.</td>
</tr>
<tr>
<td>✨ Start Color</td>
<td>Copies in color.</td>
</tr>
<tr>
<td>✅ Stop</td>
<td>Stops copying or printing. The sheet being printed is ejected.</td>
</tr>
</tbody>
</table>

**Lights**
**Note:**

All lights will turn off if no buttons have been pressed for 15 minutes. When a button is pressed, the lights will return to their former state.

<table>
<thead>
<tr>
<th>Light</th>
<th>Pattern</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>On</td>
<td>Indicates this product is on.</td>
</tr>
<tr>
<td></td>
<td>Flashing (slow)</td>
<td>Indicates this product is copying, printing, receiving data, printing, scanning, accessing a memory card, having an ink cartridge replaced, charging ink, or cleaning the print head.</td>
</tr>
<tr>
<td></td>
<td>Flashing (fast)</td>
<td>Indicates this product is being turned off.</td>
</tr>
<tr>
<td>Error</td>
<td>On or Flashing</td>
<td>Indicates that an error has occurred. (For details, see &quot;Troubleshooting&quot; in the Basic Operation Guide.)</td>
</tr>
<tr>
<td>⊕</td>
<td>Flashing</td>
<td>Indicates that the ink level in a cartridge is low.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Indicates that an ink cartridge is empty or missing.</td>
</tr>
<tr>
<td>Memory Card</td>
<td>On</td>
<td>Indicates that memory card printing is selected and the print option has been selected.</td>
</tr>
<tr>
<td>(CX4500 only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Print Index Sheet, Print From Index Sheet, Print All/DPOF)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy (LED window)</td>
<td>1 to 9</td>
<td>Indicates the number of copies.</td>
</tr>
<tr>
<td></td>
<td>_</td>
<td>Indicates that 100 copies will be made.</td>
</tr>
<tr>
<td></td>
<td>Indicates that an error has occurred.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Indicates that the adjust lever has been set to the position.</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>Indicates that the adjust lever has been set to the standard position.</td>
<td></td>
</tr>
<tr>
<td>. (dot)</td>
<td>Indicates that the control panel is operating at reduced power. (The product switches to this mode after 15 minutes of inactivity. The panel reverts to normal power when any key other than the On button is pressed.)</td>
<td></td>
</tr>
<tr>
<td>Plain Paper Photo Paper</td>
<td>On</td>
<td>Indicates the selected paper type.</td>
</tr>
<tr>
<td>Letter 4&quot; x 6&quot;</td>
<td>On</td>
<td>Indicates the selected paper size.</td>
</tr>
<tr>
<td>Fit to Page</td>
<td>On</td>
<td>Indicates that the copy will be resized to fit the selected paper size.</td>
</tr>
<tr>
<td>Memory Card Access Light</td>
<td>On</td>
<td>Indicates that a memory card has been inserted into the memory card slot.</td>
</tr>
<tr>
<td>Flashing</td>
<td>Indicates that the product is reading data from the memory card. Never eject a card while this light or the On light is flashing, otherwise the data on the card may be damaged.</td>
<td></td>
</tr>
</tbody>
</table>
Product Information

**Consumable Products**

The following ink cartridges and Epson special media are available for this product.

You can use the following cartridges with this product.

<table>
<thead>
<tr>
<th>Black ink cartridge</th>
<th>Black</th>
<th>T046120</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color ink cartridge</td>
<td>Cyan Magenta Yellow</td>
<td>T047220</td>
</tr>
<tr>
<td></td>
<td></td>
<td>T047320</td>
</tr>
<tr>
<td></td>
<td></td>
<td>T047420</td>
</tr>
</tbody>
</table>

**Media types**

Epson offers specially designed media for this product to meet most high-quality printing needs. See Media Type Settings.

**Note:**

- The availability of special media varies by location.

- For the latest information on media available in your area, contact Epson. See Contacting Customer Support.
Exif Print

Note:
You need to install EPSON PhotoQuicker before you can use the Exif Print function.

Effectiveness

Exif Print

When taking photographs using an Exif Print compatible digital camera, information about camera settings and scene conditions when the photograph was taken is embedded in the photo data. Such information includes exposure mode, white balance, gain control, contrast, saturation, and sharpness, among other attributes. The printer then corrects and enhances the photo data using this information and prints an image that reflects the original scene captured by the digital camera.

Printout without Exif Print
Printout with Exif Print

When Exif Print data is embedded in the photo data, the printer interprets how to adjust and print the image.

Note:

The images above are samples. Print results depend on this product.
Printing

Printer Software Introductions

Scanning

Scanner Software Introductions

Replacing Ink Cartridges

Maintenance

Troubleshooting

Product Information

- Parts
- Control Panel Functions
- Consumable Products
- Exif Print

- Using Memory Card

Product Specifications

- System Requirements
- Printing
- Scanning
- Paper
- Built-in card slots
- Ink Cartridges
- Mechanical
- Electrical
- Environmental
- Standards and Approvals
- USB Interface
Introduction

This section guides you through the procedures for different kinds of printing.

**Printing Text and Web Pages**

Explains how to print documents and images on various sizes or kinds of single-sheet paper.

**Printing Photos**

Explains how to print photos on various sizes or kinds of single-sheet paper.
Printing on Envelopes

Explains how to print on envelopes.
Printing / How to Print

Printing Text and Web Pages

- Handling single sheets of paper
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

1. Before turning on this product, make sure it is connected to your computer.

2. Press the On button to turn on this product. The On light on the control panel flashes then remains lit, indicating that this product has completed its initialization.
Handling single sheets of paper

Refer to the section below for details on loading single sheets of paper.

Loading Single Sheets of Paper

When using special media, refer to the section below.

Using Special Media

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

Accessing the Printer Software for Windows
Click the **Main** tab, then make the Quality Option setting. For details, see online help.

Make the appropriate Type setting.

Media Type Settings

Make the appropriate Size setting. You can also define a custom paper size. For details, see the following section.

Making User Defined Paper Sizes

Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.
Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS 9

3. Make the appropriate Paper Size setting. You can also define a custom paper size. For details, see the following section.

   For Mac OS 9

4. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

5. Click OK to save the settings and close the Page Setup dialog box.

6. Print your data.

7. Click OK to close the printer driver settings dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS

Make the appropriate Media Type setting.

Click Print to start printing.
Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS X

3. Make the appropriate Format for setting.

4. Make the appropriate Paper Size and Orientation settings.

5. Click OK to close the Page Setup dialog box.

6. Access the Print dialog box.
Make the Printer setting so that it matches the Format for setting you made in the Page Setup dialog box in step 3. Then make the Copies & Pages settings.

Note:
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system’s documentation for details.

Select **Print Settings** from the pop-up menu.

Make the appropriate Media Type, Color, and Mode settings. See online help for details.

Click **Print** to start printing.
Make sure the adjust lever is in the proper position for the media used.
Before turning on this product, make sure it is connected to your computer.

Press the On button to turn on this product. The On light on the control panel flashes then remains lit, indicating that this product has completed its initialization.
Handling single sheets of paper

Refer to the section below for details on loading single sheets of paper.

Loading Single Sheets of Paper

When using special media, refer to the section below.

Using Special Media

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.
3 Click the **Main** tab, then make the Quality Option setting. For details, see online help.

4 Make the appropriate Type setting.

   Media Type

   Settings

5 Make the appropriate Size setting. You can also define a custom paper size. For details, see the following section.

   Making User Defined Paper Sizes

6 Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.
Driver settings for Mac OS 9

1. Open the file you want to print.

2. Access the Page Setup dialog box.

3. Make the appropriate Paper Size setting. You can also define a custom paper size. For details, see the following section.

4. Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your printout.

5. Click **OK** to save the settings and close the Page Setup dialog box.

Click **OK** to close the printer driver settings dialog box.

Print your data.
6. Access the Print dialog box.

Accessing the Printer Software for Mac OS

7. Make the appropriate Media Type setting.

Media Type Settings

8. Click Print to start printing.
Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS X

3. Make the appropriate Format for setting.

4. Make the appropriate Paper Size and Orientation settings.

5. Click **OK** to close the Page Setup dialog box.

6. Access the Print dialog box.
Accessing the Printer Software for Mac OS X

7 Make the Printer setting so that it matches the Format for setting you made in the Page Setup dialog box in step 3. Then make the Copies & Pages settings.

![Printer Settings Screenshot]

- **Copies & Pages**
  - **Copies:** 1
  - **Collated:**
  - **Pages:** All

Note:
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system’s documentation for details.

8 Select **Print Settings** from the pop-up menu.

9 Make the appropriate Media Type, Color, and Mode settings. See online help for details.

Media Type Settings

10 Click **Print** to start printing.
Make sure the adjust lever is in the proper position for the media used.
Printing / How to Print

Printing on Envelopes

- Handling envelopes
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

Before turning on this product, make sure it is connected to your computer.

Press the On button to turn on this product. The On light on the control panel flashes then remains lit, indicating that this product has completed its initialization.
Handling envelopes

Refer to the section below for loading envelopes.

See Printable area for the printable area.

Driver settings for Windows

1. Open the file you want to print.

2. Access the printer driver.

3. Click the Main tab, then make the Quality Option setting. For details, see online help.

4. Select Plain Paper/Bright White Paper as the Type setting.

5. Select the appropriate envelope size from the available Size settings. You can also define a custom paper size. For details, see the following section.

Making User Defined Paper Sizes
Select **Landscape** (wide) as the Orientation setting.

Click **OK** to close the printer driver settings dialog box.

Print your data.

**Driver settings for Mac OS 9**

Open the file you want to print.
Access the Page Setup dialog box.

Select the appropriate envelope size from the available Paper Size settings. You can also define a custom paper size. For details, see the following section.

Select Landscape (wide) as the Orientation setting.

Click OK to save the settings and close the Page Setup dialog box.

Access the Print dialog box.

Select Plain Paper/Bright White Paper as the Media Type setting.
Click **Print** to start printing.

Driver settings for Mac OS X

1. Open the file you want to print.

2. Access the Page Setup dialog box.

   **Accessing the Printer Software for Mac OS X**

3. Select **Stylus CX3500** or **Stylus CX4500** as the Format for setting.

4. Select the appropriate envelope size as the Paper Size setting.

5. Select **Landscape** (wide) as the Orientation setting.
Click **OK** to close the Page Setup dialog box.

Access the Print dialog box.

**Accessing the Printer Software for Mac OS**

Select **Stylus CX3500** or **Stylus CX4500** as the Printer setting, then make the Copies & Pages settings.

Select **Stylus CX3500** or **Stylus CX4500** as the Printer setting, then make the Copies & Pages settings.
Note:
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Select **Plain Paper/Bright White Paper** as the Media Type setting, then make the appropriate Color and Mode settings. For details, see online help.

Click **Print** to start printing.
Loading Single Sheets of Paper

This section provides instructions on how to load paper in the sheet feeder.

Note:

Leave enough space in front of this product for paper to be fully ejected.

Open the paper support, then slide out the extension, and then open the feeder guard.

Lower the output tray and slide out the extension.
3 Slide out the left edge guide so that the distance between the two edge guides is slightly wider than the paper you are going to load.

4 Load the paper with the printable side up so it is against the right edge guide, and slide it into the sheet feeder.
Slide the left edge guide so that it meets the left edge of the paper.

**Note:**

- Always load paper short edge first into the sheet feeder.

- Make sure that the paper stack is flush with or lower than the triangular load-limit mark on the edge guide.

- Make sure that the paper is loaded under the tabs inside the edge guides.

- Make sure the adjust lever is set to the position. If you print on paper other than envelopes when the lever is set to the position, print quality and speed will be compromised.
Set the feeder guard back.

**Note:**

If the paper is curled, flatten it or curl it slightly toward the opposite side before loading. Printing on curled paper may cause ink to smear on your printout.
Using Special Media

Loading capacities for Epson special media
Storing Epson Photo Paper

You can achieve good results with most types of plain bond paper. However, coated paper provides superior printouts because it absorbs less ink.

Epson provides special media that are formulated for the ink used in this product. Epson recommends using media distributed by Epson to ensure high-quality results. See Loading capacities for Epson special media for a complete list of these products.

When loading special media distributed by Epson, read the instruction sheets packed with the media first and keep the following points in mind.

Caution:

Cleaning sheets packaged with Epson special media should not be used with this product. The cleaning function performed by these sheets is not necessary with this type of this product, and the sheets could jam in this product.

Note:

- Load the media into the sheet feeder printable side up. See the instruction sheets packed with the media to determine which side is the printable side. Some types of media have cut corners to help identify the correct loading direction, as shown in the illustration.
If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may cause ink to smear on your printout.

Loading capacities for Epson special media

Refer to the chart below to find the loading capacities for Epson special media.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Loading Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Paper</td>
<td>Up to 20 sheets.</td>
</tr>
<tr>
<td>Glossy Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper</td>
<td></td>
</tr>
<tr>
<td>Paper Type</td>
<td>Quantity</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Premium Ink Jet Plain Paper</td>
<td>Up to 100 sheets.</td>
</tr>
<tr>
<td>Bright White Ink Jet Paper</td>
<td>Up to 80 sheets.</td>
</tr>
<tr>
<td>Matte Paper-Heavyweight</td>
<td>Up to 20 sheets.</td>
</tr>
<tr>
<td>Archival Matte Paper</td>
<td>-</td>
</tr>
<tr>
<td>DURABrite Photo Paper</td>
<td>-</td>
</tr>
<tr>
<td>DURABrite Ink Glossy Photo Paper</td>
<td>Up to 50 sheets</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Paper</td>
<td>Up to 100 sheets.</td>
</tr>
<tr>
<td>Photo Quality Ink Jet Cards</td>
<td>Up to 30 cards.</td>
</tr>
<tr>
<td>Double-Sided Matte Paper</td>
<td>One sheet at a time.</td>
</tr>
</tbody>
</table>

**Note:**

Be careful not to print on support sheets that are loaded under special media sheets.

---

**Storing Epson Photo Paper**

Return unused paper to the original package as soon as you finish printing. Epson recommends storing your printouts in a resealable plastic bag. Keep them away from high temperature, humidity, and direct sunlight.
Loading Envelopes

Follow the steps below to load envelopes into this product.

1. Open the paper support, then slide out the extension, and then open the feeder guard.

2. Lower the output tray and slide out the extension.
3 Set the adjust lever to the position.

Note:
Return the adjust lever to the position after printing envelopes. If the adjust lever is not returned to the position, the print speed when printing single sheets will decrease, and the print quality may decline.

4 Slide out the left edge guide so that the distance between the two edge guides is slightly wider than the envelopes you are going to load.
Load the envelopes with the short edge first and the flap side to the left against the right edge guide, and slide them into the sheet feeder.

Note:
You can load up to 10 envelopes at a time in the sheet feeder.

Slide the left edge guide so that it meets the left edge of the paper.

Note:
Make sure that the envelopes is loaded under the tabs inside the edge guides.
Set the feeder guard back.

**Note:**

- If you are going to print a large number of envelopes, first try printing one sheet to confirm that it can be printed properly. You can then print the rest of the envelopes.

- The folding quality and thickness of envelopes vary widely. If the total thickness of the stack of envelopes exceeds 0.4 inch (10 mm), press each envelope in the stack flat before loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a time.

- Do not use envelopes that are curled or folded.

- Flatten the envelope flaps before loading.

- Flatten the loading edge of the envelope before loading.

- Avoid using envelopes that are too thin as they may curl during printing.

- Do the following if paper cannot be fed properly. Feed envelopes with the flap side on the right side and select the **Rotate 180°** check box on the Page Layout menu (Windows) or the **Rotate by 180 degrees** check box in the Page Setup dialog box (Macintosh). Press the four corners of the envelopes firmly with your fingers to make the envelopes flat.
Media Type Settings

The Media Type setting determines what other settings are available, so you should always make this setting first.

Refer to the corresponding media type under which it is grouped. For some media, there are several Media Type settings from which to choose.

Plain Paper/Bright White Paper

Plain paper

Envelopes

EPSON Premium Bright White Ink Jet Paper (Letter) S041586

Matte Paper - HeavyWeight

EPSON Matte Paper HeavyWeight (Letter) S041257-ML

EPSON Matte Paper HeavyWeight (8 x 10") S041467

EPSON Double-Sided Matte Paper (Letter) S041568

EPSON Photo Quality Ink Jet Paper (A4) S041061

EPSON Photo Quality Ink Jet Paper (Letter) S041062-ML

EPSON Photo Quality Ink Jet Cards (A6) S041054
DURABrite Ink Glossy Photo Paper/DURABrite Photo Paper

DURABrite Ink Glossy Photo Paper (Letter)  S041731

DURABrite Ink Glossy Photo Paper (4 x 6”)  S041734

Glossy Photo Paper/Photo Papers

EPSON Photo Paper (Letter)  S041141-ML

EPSON Photo Paper (4 x 6”)  S041134

EPSON Photo Paper (Panoramic)  S041145

EPSON Photo Paper (4 x 6” Borderless)  S041809

EPSON Glossy Photo Paper (Letter)  S041141-ML
S041271
S041272
S041649

EPSON Glossy Photo Paper (4 x 6”)  S041134

EPSON Premium Semigloss Photo Paper (Letter)  S041331-ML

Note:
The availability of special media varies by location. For the latest information on media available, check the Epson customer support web site. See Contacting Customer Support.
Making User Defined Paper Sizes

For Windows

You can define a custom paper size and add it to the list.

Select **User Defined** as the Size setting. The User Defined Paper Size dialog box appears.

1. Type a name for your paper size in the Paper Size Name box.
2. Choose either **cm** or **inch** as the Unit setting.
Specify the width and height for your paper size. The range of available size is shown under each text box.

Note:

Although you can define a large range of paper sizes, the size of paper you can feed into this product is limited by the size of the sheet feeder on your product. Therefore, if necessary, it is recommended that you reduce or enlarge documents to fit paper within the range of your product's capabilities.

Click Save, then click OK to return to the Main menu. Your new user-defined paper size name appears as the Size setting.

To delete a custom paper size from the list, open the User Defined Paper Size dialog and select the user-defined paper size name you want to delete. Then, click Delete.
For Mac OS 9

You can define a custom paper size by either creating a new paper size or copying and modifying an existing one. Refer to the appropriate section below.

Creating a new paper size

If the appropriate paper size is not included in the Paper Size list in the Page Setup dialog box, follow the steps below to define a new custom paper size.

1. In the Page Setup dialog box, click Customize. The following dialog box appears.

2. To define a new paper size, click New. The dialog box now allows you to enter a name for the new size.
3 Type a unique name for the paper size in the Paper Size list.

4 Choose either \textbf{cm} or \textbf{inch} as the Unit setting.

5 Enter the width and the height of your paper by typing the values in the appropriate text boxes.

\textbf{Note:}

Although you can define a large range of paper sizes, the size of paper you can feed into this product is limited by the size of the sheet feeder on your product. Therefore, if necessary, it is recommended that you reduce or enlarge documents to fit paper within the range of your product's capabilities.

6 Specify the margins by typing in the Margin text boxes or by manipulating the margins in the preview image.

7 Click \textbf{OK} to return to the Page Setup dialog box.
You can define up to 100 paper sizes. The paper size names you create will appear in the Paper Size list.

To delete a custom paper size, click **Customize**, select the paper size from the list in the Custom Paper dialog box, then click **Delete**.

**Copying an existing paper size to use as a template**

Follow the steps below to copy an existing paper size to use as a template which you can modify.

1. Select the existing paper size to be copied and click **Copy**.

2. Choose either **cm** or **inch** as the Unit setting.

3. Specify the margins by typing in the Margin text boxes or by manipulating the margins in the preview image.

4. Click **OK**.
Introduction to Various Printing Options

This product provides you with a variety of different printing options. You can print in various formats, and you can print using many different types of paper.

The sections that follow the introduction explain procedures for each type of printing. Click the title of each printing option to see more details.

**Borderless Printing**

Lets you print without margins on all four sides of the paper.

**Double-Sided Printing**

Lets you print on both sides of the paper.

**Note:**

This feature is not available with Mac OS X.
Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer software.

Note:

This feature is not available with Mac OS X.

Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper.
Poster Printing

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of paper, and then make a poster.

Note:

This feature is not available with Mac OS X.

Watermark Printing
Lets you print text or an image as a watermark on your printout.

Note:

This feature is not available with Mac OS X.

For example, you can put "Confidential" on an important document.
Borderless Printing

Compatible media
Preparing the print data
Loading paper
Driver settings for Windows
Driver settings for Mac OS 9
Driver settings for Mac OS X

This product allows you to print without margins on all four sides of the paper. Follow the steps described below for Borderless printing.

Compatible media

You can use the following media with this feature:

<table>
<thead>
<tr>
<th>Matte Paper - Heavyweight</th>
<th>Letter, 8x10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossy Photo Paper</td>
<td>Letter, 8x10, 4x6</td>
</tr>
</tbody>
</table>
Note:

- Printing with this feature takes longer than with normal printing.
- Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing on media other than those listed above. Print a single sheet to check the quality before printing large jobs.

Preparing the print data

Because this option enlarges the image to a size slightly larger than the paper size, the portion of the image that extends beyond the edges of the paper will not be printed.

When creating data in an application for print, you need to adjust the data to the size of the paper. If your application has margin settings, make sure they are set to zero before printing.

Loading paper

After you have selected the media, load it in the sheet feeder. Refer to the following section for details.

Driver settings for Windows
After you have loaded the media, change your printer driver settings for Borderless printing.

1. Access the printer driver.

2. Accessing the Printer Software for Windows

3. Click the Main tab, then make the Quality Option setting. For details, see online help.

4. Select the Borderless check box.

5. Make the appropriate Type setting.

6. Media Type Settings

7. Make the appropriate Size setting.
Click **OK** to close the printer driver settings dialog box.

After finishing all steps above, start printing. Print one test copy and examine the results before printing an entire job.

**Note:**

You can control the amount of the image that extends beyond the edges of the paper during borderless printing. When the **Borderless** check box is selected on the Main menu, the **Borderless Expansion** slider becomes available on the Page Layout menu.

**Driver settings for Mac OS 9**

After you have loaded the media, change your printer driver settings for Borderless printing.
Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS 9

Make the appropriate Paper Size setting.

Select the **Borderless** check box.

Click **OK** to save the settings and close the Page Setup dialog box.

Access the Print dialog box.

Accessing the Printer Software for Mac OS 9

Make the appropriate Media Type setting.

**Media Type** Settings
Click **Print** to start printing.

**Note:**

- Print one test copy and examine the results before printing an entire job.
- You can control the amount of the image that extends beyond the edges of the paper during borderless printing. When the **Borderless** check box is selected on the Page Setup dialog box, the **Expansion** button becomes available.

**Driver settings for Mac OS X**

After you have loaded the media, change your printer driver settings for Borderless printing.

1. Access the **Page Setup** dialog box.

   **Accessing the Printer Software for Mac OS X**

2. Select **Stylus CX3500** or **Stylus CX4500** as the Format for setting.

3. Make the appropriate Paper Size settings with the borderless attribute.

4. Make the appropriate Orientation setting.

5. Click **OK** to close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS

Select **Stylus CX3500** or **Stylus CX4500** as the Print setting, then make the Copies & Pages settings.

**Note:**
The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Make the appropriate Media Type, Color, and Mode settings. See online help for details.

Media Type
Settings

Click **Print** to start printing.
Note:

- Print one test copy and examine the results before printing an entire job.

- You can control the amount of the image that extends beyond the edges of the paper during borderless printing. See online help for details.
Double-Sided Printing

- Standard double-sided printing for Windows
- Standard double-sided printing for Macintosh
- Folded booklet double-sided printing for Windows
- Folded Booklet double-sided printing for Macintosh

There are two types of double-sided printing available. Standard double-sided printing allows you to print the odd-numbered pages first. Once these pages are printed, they can be reloaded to print the even-numbered pages onto the opposite side of the paper.

Folded Booklet double-sided printing allows you to make single-fold booklets. To create it, the pages that appear on the outside (after the page is folded) are printed first. The pages that will appear inside the booklet can then be printed after the paper is reloaded into the sheet feeder as shown in the illustration below.
A booklet can be created by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the second sheet of paper, and pages 9 and 12 on the third sheet of paper. After these sheets are reloaded into the sheet feeder, you can then print pages 2 and 3 on the back of the first sheet of paper, pages 6 and 7 on the back of the second sheet of paper, and pages 10 and 11 on the back of the third sheet of paper. The resulting pages can then be folded and bound together into a booklet.

**Note:**

- This feature is not available with Mac OS X.
- This feature is not available when selecting the **Borderless** check box on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).
- This feature is not available when this product is accessed over a network or is used as a shared printer.
- Depending on the media type, stacks of up to 30 sheets can be loaded into the sheet feeder during double-sided printing.

- Only use media types that are suitable for double-sided printing. Otherwise, the printout quality may deteriorate.

- Depending on the media type and the amount of ink used to print text and images, ink may bleed through to the other side of the paper.

- The surface of the paper may be smeared during double-sided printing.

**Standard double-sided printing for Windows**

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the printer driver.

   **Accessing the Printer Software for Windows**

2. Click the **Main** tab, then make the Quality Option setting. For details, see online help.

3. Make the appropriate Type setting.

   **Media Type Settings**

4. Make the appropriate Size setting.
5. Click the **Page Layout** tab, then select the **Double-Sided Printing** check box.

6. Click **Margins** to open the Margins dialog box.
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.
Choose **cm** or **inch** as the Unit setting. Then, specify the width of the binding margin. You can enter any width from 3 mm to 30 mm, or from 0.12 inches to 1.18 inches.

**Note:**

The actual binding margin may be different from the specified settings depending on your application. Experiment with a few sheets to examine actual results before printing the entire job.

Click **OK** to return to the Page Layout menu. Then, click **OK** to save your settings.

Load paper in the sheet feeder, then send the print job from your application. Instructions for generating the even-numbered pages will be displayed while the odd-numbered pages are printed.

**Loading Single Sheets of Paper**

Follow the on-screen instructions to reload the paper.
Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.

- Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

- If a paper jam occurs, see Paper Does Not Feed Correctly

Once the paper is reloaded, click Resume to print the even-numbered pages.

Standard double-sided printing for Macintosh
Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the Page Setup dialog box.

2. Make the appropriate Paper Size setting.

3. Select the **Double-Sided Printing** check box.

4. Click **Margins**.

Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.
Specify the width of the binding margin in the text box. You can enter any width from 0.12 inch to 1.18 inch or from 0.3 cm to 3.0 cm.

Note:
The actual binding margin may be different from the specified settings depending on your application. Experiment with a few sheets to examine actual results before printing the entire job.

Click OK to return to the Page Setup dialog box. Then, click OK to save your settings and close the dialog box.

Access the Print dialog box.

Accessing the Printer Software for Mac OS

Make the appropriate Media Type setting.

Load paper into the sheet feeder, then click Print to start printing. Instructions for generating the even-numbered pages will be displayed while the odd-numbered pages are printed.

Loading Single Sheets of Paper
Follow the on-screen instructions to reload the paper.

Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.
Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

If a paper jam occurs, see Paper Does Not Feed Correctly

Once the paper is reloaded, click Resume to print the even-numbered pages.

Folded booklet double-sided printing for Windows

Use the following steps to create a folded booklet as described at the beginning of this section.

1. Access the printer driver.

   Accessing the Printer Software for Windows

2. Click the Main tab, then make the Quality Option setting. For details, see online help.

3. Make the appropriate Type setting.

   Media Type Settings

4. Make the appropriate Size setting.
Click the **Page Layout** tab and select the **Double-Sided Printing** check box. Then, select the **Folded Booklet** check box.
Click **Margins** to open the Margins dialog box.
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

**Note:**

When **Portrait** is selected as the Orientation setting on the Main menu, the **Left** or **Right** binding positions are available. The **Top** binding position is available when **Landscape** is selected as the Orientation setting.

Choose **cm** or **inch** as the Unit setting. Specify the width of the binding margin. You can enter any width from 3 mm to 30 mm, or from 0.12 inches to 1.18 inches. The specified margin width will be used on both sides of the fold. For example, if a 10-mm margin is specified, a 20-mm margin will be inserted (a margin of 10 mm will be placed on each side of the fold).
Click **OK** to return to the Page Layout menu. Then, click **OK** to save your settings.

Load paper into the sheet feeder, then send the print job from your application. Instructions for printing the inside pages will be displayed while the outside pages are printed.

**Loading Single Sheets of Paper**

Follow the on-screen instructions to reload the paper.
Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.

- Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not reloaded correctly.

- If a paper jam occurs, see Paper Does Not Feed Correctly.

Once the paper is reloaded, click Resume to print the inside pages.

Once printing is complete, fold the sheets and bind them together using a stapler or other binding method.
Folded Booklet double-sided printing for Macintosh

Use the following steps to create a folded booklet as described at the beginning of this section.

1. Access the Page Setup dialog box.

2. Make the appropriate Paper Size setting.

3. Select the **Double-Sided Printing** check box. Then, select the **Folded Booklet** check box.

4. Click **Margins**.

[Image of EPSON printer settings dialog box with Double-Sided Printing and Folded Booklet options highlighted]

[Accessing the Printer Software for Mac OS 9]
Specify the edge of the paper where the binding will be placed. You can choose **Left**, **Top**, or **Right**.

**Note:**

When **Portrait** is selected as the Orientation setting in the Page Setup dialog box, the **Left** or **Right** binding positions are available. The **Top** binding position is available when **Landscape** is selected as the Orientation setting.

Specify the width of the binding margin in the text box. You can enter any width from 0.12 inch to 1.18 inch or from 3 mm to 30 mm. The specified margin width will be used on both sides of the fold. For example, if a 10 mm margin is specified, a 20 mm margin will be inserted (a margin of 10 mm will be placed on each side of the fold).
Margin

Click OK to return to the Page Setup dialog box. Then, click OK to save your settings and close the dialog box.

Access the Print dialog box.

Accessing the Printer Software for Mac OS

Make the appropriate Media Type setting.

Load paper into the sheet feeder, then click Print to start printing. Instructions for printing the inside pages will be displayed while the outside pages are printed.

Loading Single Sheets of Paper

Follow the on-screen instructions to reload the paper.
Note:

- The paper may curl during printing due to the amount of ink used. Should this occur, slightly curl the sheets in the opposite direction before reloading them into the sheet feeder.

- Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack into the sheet feeder.

- Follow the instructions provided when reloading the printouts. Paper jams or improperly placed binding margins may occur if the printouts are not loaded correctly.

- If a paper jam occurs, see Paper Does Not Feed Correctly.

Once the paper is reloaded, click Resume to print the inside pages.

Once printing is complete, fold the sheets and bind them together using a stapler or other binding method.
**Fit to Page Printing**

Loading paper

Driver settings for Windows

Driver settings for Macintosh

Fit to Page printing automatically fits images or text you want to print to the paper size you select in the printer software, or it allows you to manually resize the image.

![Image showing fit to page printing concept]

**Note:**

- This feature is not available with Mac OS X.

- This feature is not available when selecting the **Borderless** check box on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

**Loading paper**

Load paper into the sheet feeder.

Loading Single Sheets of Paper
Driver settings for Windows

Access the printer driver.

Accessing the Printer Software for Windows

Click the Main tab, then make the Quality Option setting. For details, see online help.

Make the appropriate Type setting.
Make the appropriate Size setting.

Click the **Page Layout** tab.

Select the **Reduce/Enlarge Document** check box. You can select the following settings to change the size of your document.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>By Output Paper Size</strong></td>
<td>Proportionally enlarges or reduces the size of your document to make it fit the paper size selected in the By Output Paper Size list.</td>
</tr>
<tr>
<td><strong>By Percentage</strong></td>
<td>Allows you to manually reduce or enlarge an image. Click the arrows to select a percentage between 10 and 400.</td>
</tr>
</tbody>
</table>

6. Select the paper size loaded in the sheet feeder from the drop-down list when selecting **By Output Paper Size**, or use the arrows to choose a percentage when selecting **By Percentage**.

7. Click **OK** to close the printer driver settings dialog box.

After finishing all steps above, start printing.

---

**Driver settings for Macintosh**

1. Access the Page Setup dialog box.

2. Make the appropriate **Paper Size** setting.

3. Click **OK** to save the settings and close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS

Make the appropriate Media Type setting.

Media Type Settings

Click the Layout icon button.

Select the **Fit to Page** check box.
Select the paper size loaded in the sheet feeder from the Output Paper Size list.

Click **OK** to save the settings and close the Layout dialog box.

Click **Print** to start printing.
Printing / Various Printing Options

Pages Per Sheet Printing

- Loading paper
- Driver settings for Windows
- Driver settings for Mac OS 9
- Driver settings for Mac OS X

Pages Per Sheet printing allows you to print two or four pages on a single sheet of paper.

![Image of Pages Per Sheet printing example]

**Note:**

This feature is not available when the **Borderless** box is checked on the Main menu (Windows) or in the Page Setup dialog box (Mac OS 9).

Loading paper

Load paper into the sheet feeder.

Loading Single Sheets of Paper
Driver settings for Windows

Access the printer driver.

Accessing the Printer Software for Windows

Click the **Main** tab, then make the Quality Option setting. For details, see online help.

Make the appropriate Type setting.

**Media Type Settings**

Make the appropriate Size setting.
Click the **Page Layout** tab and select the **Multi Page** check box. Then, select **Pages Per Sheet**.
6 Make the following settings for Pages Per Sheet printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2, 4</strong></td>
<td>Prints two or four pages of your document on a single piece of paper.</td>
</tr>
<tr>
<td>Print Page Borders</td>
<td>Prints frames around the pages printed on each sheet.</td>
</tr>
<tr>
<td>Page Order</td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper. Some settings may be unavailable, depending on the Orientation setting on the Main menu.</td>
</tr>
</tbody>
</table>

7 Click **OK** to close the printer driver settings dialog box.
After finishing all of the steps above, start printing.

Driver settings for Mac OS 9

1. Access the Page Setup dialog box.

   Accessing the Printer Software for Mac OS 9

2. Make the appropriate Paper Size setting.

3. Click OK to save the settings and close the Page Setup dialog box.

   ![Page Setup Dialog]

4. Access the Print dialog box.

   Accessing the Printer Software for Mac OS 9

5. Make the appropriate Media Type setting.
6. Click the Layout icon button.

7. Select the Multi-Page check box in the Layout dialog box, then select Pages Per Sheet.
Make the following settings for Pages Per Sheet printing.

<table>
<thead>
<tr>
<th>2 Pages, 4 Pages</th>
<th>Prints two or four pages of your document on a single piece of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Order</td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper. Some settings may be unavailable, depending on the Orientation setting in the Page Setup dialog box.</td>
</tr>
<tr>
<td>Print page frames</td>
<td>Prints frames around the pages printed on each sheet.</td>
</tr>
</tbody>
</table>

Click **OK** to save the settings and close the Layout dialog box.

Click **Print** to start printing.

**Driver settings for Mac OS X**

Access the Page Setup dialog box.

**Accessing the Printer Software for Mac OS X**

Select **Stylus CX4600** as the Format for setting.

Make the appropriate Paper Size and Orientation settings.
Click **OK** to close the Page Setup dialog box.

Access the **Print** dialog box.

Accessing the Printer Software for Mac OS X

Select **Stylus CX4600** as the Printer setting.

Make the Copies & Pages settings.
Select **Layout** from the pop-up menu.

Make the following settings.

<table>
<thead>
<tr>
<th><strong>Pages per Sheet</strong></th>
<th>Prints multiple pages of your document on a single piece of paper. You can choose from 1, 2, 4, 6, 9, or 16.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout Direction</strong></td>
<td>Allows you to specify the order in which the pages will be printed on the sheet of paper.</td>
</tr>
<tr>
<td><strong>Border</strong></td>
<td>Prints a border around the pages printed on each sheet. You can choose from None, Single hairline, Single thin line, Double hairline, or Double thin line.</td>
</tr>
</tbody>
</table>

**Note:**

The Copies & Pages settings available are a standard feature of Mac OS X. See your operating system’s documentation for details.
The Layout settings available are a standard feature of Mac OS X. See your operating system's documentation for details.

Select **Print Settings** from the pop-up menu.

Make the appropriate Media Type, Color, and Mode settings.
Click **Print** to start printing.
Poster Printing

- Loading paper
- Driver settings for Windows
- Driver settings for Macintosh
- How to make a poster from your printouts

Poster printing allows you to print poster-size images by enlarging one page to cover several sheets of paper.

Note:
- This feature is not available with Mac OS X.
- This feature is not available when the Borderless box is checked on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

Loading paper

Load paper into the sheet feeder.
Driver settings for Windows

Access the printer driver.

Accessing the Printer Software for Windows

Click the Main tab, then make the Quality Option setting. For details, see online help.

Make the appropriate Type setting.

Media Type Settings

Make the appropriate Size setting.
Click the Page Layout tab and select the Multi Page check box. Then select Poster Printing. Click the up or down arrow to select 2x2, 3x3, or 4x4.
Click **Settings** to adjust the way your poster will print. The Poster Settings dialog box opens.
Make the following settings.

<table>
<thead>
<tr>
<th><strong>Print Cutting Guides</strong></th>
<th>Select this check box to turn the cutting guide options on.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overlapping Alignment Marks</strong></td>
<td>Slightly overlaps the panels and prints alignment markers so that the panels can be aligned more precisely.</td>
</tr>
<tr>
<td><strong>Trim Lines</strong></td>
<td>Prints border lines on the panels to guide you when trimming the pages.</td>
</tr>
</tbody>
</table>

Note:
If you want to print only a few of the panels without printing the entire poster, click the panels that you do not wish to print.

8 Click OK to close the Poster Settings dialog box.

After finishing all of the steps above, start printing.

---

Driver settings for Macintosh

1 Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS

2 Make the appropriate Paper Size setting.

3 Click OK to save the settings and close the Page Setup dialog box.
Access the Print dialog box.

Accessing the Printer Software for Mac OS

Make the appropriate Media Type setting.

Media Type Settings

Click the Layout icon button.

Select the Multi-Page check box, then select Poster.
Make the following settings.

<table>
<thead>
<tr>
<th><strong>1 page covers xx sheets</strong></th>
<th>Specifies how many printed sheets of paper the enlarged document page will cover. You can choose from 4, 9, or 16 sheets.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overlapping Alignment Marks</strong></td>
<td>Slightly overlaps the panels and prints alignment markers so that the panels can be aligned more precisely.</td>
</tr>
<tr>
<td><strong>Trim Lines</strong></td>
<td>Prints border lines on the panels to guide you when trimming the pages.</td>
</tr>
<tr>
<td><strong>Panel Selection</strong></td>
<td>Click the panels you do not need to print, then click the OK button to print the remaining panels.</td>
</tr>
</tbody>
</table>
Note:

If you want to print only a few of the panels without printing the entire poster, click **Panel Selection**, click the panels that you do not wish to print, then click **OK**.

Click **OK** to save the settings and close the Layout dialog box.

Click **Print** to start printing.

How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and **Overlapping Alignment Marks** selected as the print cutting guide. Refer to the accompanying illustrations as well.

Cut off the margin of Sheet 1 along a vertical line through the center of the top and bottom cross marks, as shown in the illustration below.
2 Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets together from the back side.

3 Cut the taped sheets in two along a vertical line through the alignment markers (this time, a line to the left of the cross marks), as shown in the illustration below.

4 Align the edges of the paper together using the alignment markers and tape them from the back side of the paper.

5 Repeat the instructions from step 1 to step 4 to tape sheets 3 and 4 together.

6 Repeat the instructions from step 1 to step 4 to tape the top and bottom faces of the paper.
Cut off the remaining margins.
Watermark Printing

- Loading paper
- Printing the watermark for Windows
- Printing the watermark for Macintosh
- Creating your own watermark for Windows
- Creating your own watermark for Macintosh

Watermark printing allows you to print a text-based or an image-based watermark on your document.

Note:

- This feature is not available with Mac OS X.
- This feature is not available when selecting the Borderless check box on the Main menu (Windows) or in the Page Setup dialog box (Macintosh).

Loading paper

Load paper into the sheet feeder.
Loading Single Sheets of Paper

Printing the watermark for Windows

1. Access the printer driver software.

2. Accessing the Printer Software for Windows

   Click the **Main** tab, then make the Quality Option setting. For details, see online help.

3. Make the appropriate Type setting.

4. Media Type Settings

   Make the appropriate Size setting.
Click the **Page Layout** tab, choose the desired watermark from the Watermark list, then click **Settings**.
Specify the necessary settings for the watermark. You can change the position and size of the watermark by dragging the image within the preview window at the left of the dialog box.
Click **OK** to return to the Page Layout menu.

Click **OK** to close the printer driver settings dialog box.

Print the data from your application.

---

**Printing the watermark for Macintosh**

Access the Page Setup dialog box.

Accessing the Printer Software for Mac OS

9
2 Make the appropriate Paper Size setting.

3 Click **OK** to save the settings and close the Page Setup dialog box.

![EPSON settings dialog box]

4 Access the Print dialog box.

Accessing the Printer Software for Mac OS 9

5 Make the appropriate Media Type setting.

6 Click the Layout icon button.
Select the **Watermark** check box in the Layout dialog box, then choose the desired watermark from the Name list.

Specify the necessary settings for the watermark. You can change the position and size of the watermark by dragging the image within the preview window at the left of the dialog box.

Click **OK** to save the settings and close the Layout dialog box.
Creating your own watermark for Windows

You can add your own text-based or image-based watermarks to the watermark list.

Click **Add/Del** under Watermark on the Page Layout menu. The following dialog box appears.
To use an image file as a watermark, select **BMP**. Click **Browse** to specify the bitmap file you want to use, then click **OK**. Type a name for your watermark in the Name text box, then click **Save**.

To create a text-based watermark, select **Text**. Type your text in the Text text box. The text that you enter will also be used as the watermark name. If you want to change the watermark name, type a new name in the Name text box, then click **Save**.

Click **OK** to return to the Page Layout menu.

Click **Settings**. The following dialog box appears.

![Watermark Dialog Box](image)

Make sure that the appropriate watermark is selected in the Watermark list, then make the Color, Position, Density, Size, Font, Font Style, and Angle settings. For details, see online help. Your settings are reflected in the display at the left side of the dialog box.

When you finish making settings, click **OK**.
Creating your own watermark for Macintosh

You can add your own text-based or image-based watermarks to the watermark list.

Click Add/Del beside the Name list. The following dialog box appears.

To use an image file as a watermark, click Add PICT. Specify the desired image file, then click Open.

To create a text-based watermark, click Add Text. Type the text in the Text box, select a font and a text style, then click OK.
3 The image file name or the watermark text appears in the Mark Name list in the Watermark dialog box. To change the name of an image watermark, select it from the list, then type a new name. When a text watermark is selected in the Name list, you can edit the text or change the font and text style by clicking **Edit Text**.

4 Click **OK** to add your watermark to the Name list in the Layout dialog box.
Setting Up This Product on a Network

For Windows XP and 2000

This section tells you how to set up this product so that other computers on the network can use it.

**Note:**

- This section is written for small network users only. If you are on a large network and would like to share this product, consult your network administrator.

- To install software programs in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot install software programs if you log on as a Limited account user. After you install Windows XP, the user account is set as a Computer Administrator account.

- To install software programs in Windows 2000, it is necessary to log on as a user with administrative privileges. (a user who belongs to the Administrators group.)

- The figures that are provided in the following section pertain to Windows XP.

First, set up this product as a shared printer on the computer connected directly to this product. Then, add this product to each computer that will access it through the network.

**Setting up this product as a shared printer**

To share this product with other computers on a network, follow the steps below to configure the computer connected directly to this product.
For Windows XP, click **Start, Control Panel**, then double-click **Printers and Faxes**. (If the Control Panel is in Category View, click **Printers and Other Hardware**, then click **Printers and Faxes**.) For Windows 2000, click **Start**, point to **Settings**, then click **Printers**.

1. Right-click the icon for this product, then click **Sharing**.

2. Select **Share this printer**, then type a name for the shared printer.

3. **Note:**
   Do not use spaces or hyphens in the share name.
If you want Windows XP or 2000 to automatically download printer drivers for computers that are running different versions of Windows, click **Additional Drivers** and select the environment and the operating systems for the other computers. Click **OK**, then insert the software CD into the CD-ROM drive.

4. Click **OK**, or click **Close** if you installed additional drivers.

**Accessing this product through a network**

To use this product from other computers on a network, you must first add this product to each computer that will access it. Follow the steps below.

**Note:**

This product must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. See Setting up this product as a shared printer.

1. For Windows XP, click **Start**, **Control Panel**, then double-click **Printers and Faxes**. (If the Control Panel is in Category View, click **Printers and Other Hardware**, then click **Printers and Faxes**.)
   For Windows 2000, Click **Start**, point to **Settings**, then click **Printers**.

2. Double-click the **Add Printer** icon. The Add Printer Wizard appears.

3. Click **Next**.

4. Select **A network printer, or a printer attached to another computer**, then click **Next**.
On the next screen, click Next.

Double-click the icon of the computer that is directly connected to this product. Then, click the icon for this product.
Click Next and follow the on-screen instructions.

Note:

To monitor the status of a shared printer, EPSON Status Monitor 3 must be installed on each computer. EPSON Status Monitor 3 is automatically installed when you install the printer software for the first time.

For Windows Me and 98

This section tells you how to set up this product so that other computers on a network can use it.

First, set up this product as a shared printer on the computer connected directly to this product. Then, install the printer software on each computer that will access this product through the network.

Note:

This section describes how to use this product as a shared printer on a network. To connect this product directly to a network without setting it up as a shared printer, consult your network administrator.

Setting up this product as a shared printer

To share this product with other computers on a network, follow the steps below to configure the computer connected directly to this product.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click File and Print Sharing.
Select the **I want to be able to allow others to print to my printer(s)** check box and click **OK**.

![File and Print Sharing dialog box](image)

In the Network dialog box, click **OK**.

In the Control Panel, double-click the **Printers** icon.

**Note:**

- If a dialog box appears requesting that you insert the Windows Me or 98 CD-ROM, insert the CD into the CD-ROM drive, then follow the on-screen instructions.

- If a dialog box appears requesting that you restart your computer, do so, open the **Printers** folder, then continue with step 7.

Select the icon for this product in the **Printers** folder, then click **Sharing** on the File menu.

Select **Shared As**, type the information for this product as required, then click **OK**.
Accessing this product through a network

To use this product from other computers on a network, first add this product to each computer that will access it. Follow the steps below.

**Note:**

This product must be set up as a shared resource on the computer to which it is directly connected before you can access it from another computer. See Setting up this product as a shared printer.

1. Click Start, point to Settings, then click Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard appears.
3. Click Next.

4. Select **Network printer**, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly connected to this product. Then, click the icon for this product.
Click **OK** and follow the on-screen instructions.

---

**For Mac OS 9**

This section tells you how to set up this product so that you can use it on an AppleTalk network. By setting up this product as a shared printer, your local printer is connected to the network and can be used by other computers.

First, set up this product as a shared printer on the computer connected directly to this product. Next, specify the network path to this product from each computer that will use it, and install the printer software on those computers.

**Setting up this product as a shared printer**

To share this product with other computers on an AppleTalk network, follow the steps below to configure the computer connected directly to this product.
1. Turn on this product.

2. Select **Chooser** from the Apple menu, click the icon for this product, then select the port this product is connected to.

3. Click the **Setup** button. The Printer Sharing Setup dialog box opens.
Select the **Share this Printer** check box, then type the printer name and password information as necessary.

Click **OK**. The name of the shared printer will appear in the port list in the Chooser.

Close the Chooser.

**Accessing this product through a network**

To access this product from other computers on a network, follow the steps in this section for each computer that will access this product.

1. Turn on this product.

2. Install the printer software from the software CD-ROM.

3. Select **Chooser** from the Apple menu. Click an icon for this product and select the printer port that you want to use from the Select a printer port list.

   **Note:**

   Only printers that are connected to your current AppleTalk zone are available.
If the following dialog box appears, enter the password for this product, then click OK.

Select the appropriate **Background Printing** radio button to turn background printing on or off.

Close the Chooser.

For Mac OS X

Use the Printer Sharing setting, which is a standard feature of Mac OS X 10.2 or later.
See your operating system's documentation for details.
Increasing the Print Speed

General tips

Just as printing at a high resolution requires more processing time than printing at a low resolution, printing in color takes longer than printing in black-and-white because the volume of data in a color document is much greater. For this reason, it is important to be selective in your use of color if you also require a fast print speed.

However, even if your document requires the highest resolution and extensive use of color — for example, when you are printing a camera-ready composite that includes color photographs — it may still be possible to optimize the print speed by adjusting other printing conditions. Keep in mind that changing some conditions to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print speed and print quality (increasing one will decrease the other).

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Lower Faster</th>
<th>Higher Slower</th>
<th>Menu or dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print speed</td>
<td>Paper &amp; Quality Options (Windows), Print Quality (Macintosh)</td>
<td>Economy, Normal</td>
<td>Photo</td>
</tr>
<tr>
<td>Printer software settings</td>
<td>High Speed</td>
<td>On</td>
<td>Advanced dialog box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>
The table below shows the factors related to print speed only.

<table>
<thead>
<tr>
<th>Data characteristics</th>
<th>Image size</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Small</td>
<td>Large</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>Resolution</td>
<td>Low</td>
<td>High</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The table below shows the factors related to print speed only.

<table>
<thead>
<tr>
<th>Print speed</th>
<th>Faster</th>
<th>Slower</th>
<th>Menu or dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer software settings</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orientation</td>
<td>Portrait</td>
<td>Landscape</td>
<td>Main menu (Windows), Page Setup dialog box (Macintosh)</td>
</tr>
<tr>
<td>Color (Macintosh)***</td>
<td>Black</td>
<td>Color</td>
<td>Print dialog box</td>
</tr>
<tr>
<td>Edge smoothing*</td>
<td>Off</td>
<td>On</td>
<td>Advanced dialog box</td>
</tr>
<tr>
<td>Photo Enhance</td>
<td>Off</td>
<td>On</td>
<td>Main menu (Windows), Print dialog box (Macintosh)</td>
</tr>
<tr>
<td>Mirror Image*</td>
<td>Off</td>
<td>On</td>
<td>Page Layout menu (Windows), Advanced dialog box (Macintosh)</td>
</tr>
<tr>
<td></td>
<td>Collate*</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>Reverse Order*</td>
<td>Off</td>
<td></td>
<td>On</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Data characteristics</strong></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Variety of colors</td>
<td></td>
<td>Grayscale**</td>
<td>Full color</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Hardware resources</strong></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>System speed</td>
<td>Faster</td>
<td></td>
<td>Slower</td>
<td></td>
</tr>
<tr>
<td>HDD free space</td>
<td>Large</td>
<td></td>
<td>Small</td>
<td></td>
</tr>
<tr>
<td>Memory free space</td>
<td>Large</td>
<td></td>
<td>Small</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Software status</strong></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Running applications</td>
<td>One</td>
<td></td>
<td>Many</td>
<td></td>
</tr>
<tr>
<td>Virtual memory</td>
<td>Not in use</td>
<td></td>
<td>In use</td>
<td></td>
</tr>
</tbody>
</table>

* Varies depending on the printer software and application that you are using.
** Grayscale means using black ink only to print varying shades of gray, ranging from pure black to pure white.
*** Varies depending on the media type printed on.

**Using the Speed & Progress dialog box (Windows only)**

Windows users can make certain print speed settings in the Speed & Progress dialog box. Click the **Speed & Progress** button on your printer software's **Maintenance** menu. The following dialog box appears.
The settings related to print speed are listed below.

**Note:**

The specific features available in the printer software vary depending on the product model and the version of Windows that you are using.

**High speed copies**

To print multiple copies of your document faster, select **High Speed Copies**. This speeds up printing by using your hard disk space as a cache when printing multiple copies of your document.

**Show Progress Meter**

To display the Progress Meter every time you print, select **Show Progress Meter**.
Always spool RAW datatype (for Windows XP and 2000 only)

Select this check box to have Windows NT-based clients spool documents using the RAW format instead of the EMF (metafile) format (Windows NT-based applications use the EMF format by default).

Try using this option if documents spooled in EMF format do not print correctly.

Spooling RAW datatype requires less resources than EMF, so some problems ("Insufficient memory/disk space to print", "Slow print speed", etc.) can be solved by selecting the Always spool RAW datatype check box.

Note:

When spooling RAW datatype, print progress as displayed by the Progress Meter may differ from actual print progress.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box, where you can make settings for EPSON Status Monitor 3.
You can make the following settings:

<table>
<thead>
<tr>
<th><strong>Select Notification</strong></th>
<th>Displays the current error notification settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the check boxes of the error types for which you want to receive notification.</td>
</tr>
</tbody>
</table>

**Note:**
Click the **Default** button to revert all Select Notification settings to their defaults.
<table>
<thead>
<tr>
<th><strong>Select Shortcut Icon</strong></th>
<th>Select the Shortcut Icon check box and choose an icon type to have a shortcut icon placed in your Windows taskbar. You can click the shortcut icon in the taskbar to open EPSON Status Monitor 3, or right-click the icon to access some of the printer utilities.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow monitoring of shared printers</strong></td>
<td>Select this check box to allow monitoring of a shared printer by other computers.</td>
</tr>
</tbody>
</table>
Accessing the Printer Software for Windows

- From Windows applications
- From the Start menu
- From the taskbar (For Windows XP, Me, 98, and 2000)

You can access the printer software from most Windows applications, from the Windows Start menu, or the taskbar.

When you access the printer software from a Windows application, the settings that you make apply only to the application you are using.

When you access the printer software from the Start menu or the taskbar, the settings that you make apply to all of your Windows applications.

Refer to the appropriate section below.

**From Windows applications**

Follow the steps below to access the printer software.

1. Click **Print** or **Print Setup** on the **File** menu.

2. In the dialog box that appears, click **Printer**, **Setup**, **Options**, **Preferences**, or **Properties**. (Depending on your application, you may need to click any one or a combination of these buttons.) The printer software starts.

**From the Start menu**

Follow the steps below to access the printer software.
For Windows XP, click start, Control Panel, then Printers and Faxes. (If the Control Panel is in Category View, click Printers and Other Hardware, then click Printers and Faxes.)

For Windows Me, 98, and 2000, click Start, point to Settings, then click Printers.

For Windows XP and 2000, select this product, then click Printing Preferences on the File menu.

For Windows Me and 98, select this product, then click Properties on the File menu.

The printer software starts.

From the taskbar (For Windows XP, Me, 98, and 2000)

Right-click the printer icon on the taskbar, then select Printer Settings.
## Accessing the Printer Software for Mac OS 9

These dialog boxes can be accessed as described below.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Click <strong>Print</strong> on the File menu of your application or click <strong>Options</strong> in the Page Setup dialog box.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Click <strong>Page Setup</strong> on the File menu of your application.</td>
</tr>
<tr>
<td>Layout</td>
<td>Click the <img src="image" alt="Layout" /> icon button in the Print dialog box.</td>
</tr>
<tr>
<td>Utility</td>
<td>Click the <img src="image" alt="Utility" /> icon button in the Print or Page Setup dialog box.</td>
</tr>
</tbody>
</table>

In addition, the dialog boxes below are accessed from the Print dialog box.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Printing</td>
<td>Click the <img src="image" alt="Background Printing" /> icon button in the Print dialog box.</td>
</tr>
<tr>
<td>Preview</td>
<td>Click the <img src="image" alt="Preview" /> icon button in the Print dialog box and then click <strong>Preview</strong>.</td>
</tr>
<tr>
<td>Save File</td>
<td>Click the Preview icon button in the Print dialog box until the Print button changes into the <strong>Save File</strong> button, then click the <strong>Save File</strong> button.</td>
</tr>
</tbody>
</table>

[Top]
## Accessing the Printer Software for Mac OS X

These dialog boxes can be accessed as described below.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup</td>
<td>Click <strong>Page Setup</strong> on the File menu of your application.</td>
</tr>
<tr>
<td>Print</td>
<td>Click <strong>Print</strong> on the File menu of your application.</td>
</tr>
<tr>
<td>EPSON Printer Utility</td>
<td>Access in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>- Double-click the EPSON Printer Utility icon in the Applications folder in the Macintosh HD. Select this product from the Printer List, then click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Open the Applications folder on your hard drive, then open the Utilities folder and double-click the <strong>Print Center</strong> or <strong>Printer Setup Utility</strong> icon. Select any one of the appropriate printers from the list, then click the <strong>Configure</strong> or <strong>Utility</strong> button.</td>
</tr>
</tbody>
</table>
Getting Information Through Online Help for Windows

- Accessing help from your application
- Accessing help from the Windows Start menu

You can access the online help from your application or from the Windows Start Menu. Refer to the appropriate section below.

## Accessing help from your application

To access the printer software, see From Windows applications. You can get specific help with any item on a menu by right-clicking the item, then clicking the What's This? command.

You can also view a detailed explanation of a setting or option by clicking the button on the top right of the printer driver window, then clicking the item.

## Accessing help from the Windows Start menu

To access the printer software, see From the Start menu. You can get specific help related to any item on a menu by right-clicking the item, then clicking the What's This? command.

You can also view a detailed explanation of a setting or option by clicking the button on the top right of the printer driver window, then clicking the item.
Getting Information Through Online Help for Mac OS 9

Choose **Print** or **Page Setup** from the File menu of your application. Then, click the Help icon button.
Click the Help icon button when EPSON printer software settings, such as Print Settings or Color Management, are selected in the Print dialog box. For other settings, see your operating system's documentation.
Overview of the Basic Procedure

This section outlines the basic scanning procedure using a TWAIN-compliant application. For detailed instructions, see Scanning an Image.

1. Make sure this product's power cord is plugged in.

2. Place your materials on the document table.

3. Start a TWAIN-compliant application.

4. In the application, open EPSON Scan.

5. **Full Auto Mode:**
   EPSON Scan automatically previews the images and recognizes the document source and type. Images are automatically optimized and scanned.

   **Home Mode or Professional Mode:**
   Make settings to optimize images and then click **Scan**.

6. The scanned images are sent to the application.

7. Save the scanned images in the application.
Scanning an Image

- Turning on this product
- Placing your materials on the document table
- Starting the software and scanning an image

EPSON Scan provides three modes for you to make any scanning settings; Full Auto Mode, Home Mode, and Professional Mode. This section describes how to scan an image in the Full Auto Mode. The Full Auto Mode lets you scan images using automatically-adjusted settings. For more details, see Choosing an Appropriate Scanning Mode.

**Note:**
You cannot scan an image with a size that exceeds the available memory or disk space. If you try to scan the image, an alert appears on the screen.

**Note for Macintosh users:**
Most illustrations shown in this section are for Windows, so they may vary in appearance from what actually appears on your screen. The instructions are the same, except as noted.

**Caution:**
Before starting the following steps, make sure that all the necessary software including EPSON Scan has been installed. For details about how to install the software, see the Setup Sheet.

**Turning on this product**

Before turning on this product, make sure this product is connected to your computer.

Press the **On** button to turn on this product. The On light on the control panel flashes then remains lit, indicating that this product has completed its initialization.
Placing your materials on the document table

You can scan reflective documents (like photo or paper). See the appropriate link below to set your materials on the document table.

Starting the software and scanning an image

You can start EPSON Scan in the following ways.

- Start EPSON Scan directly as a stand alone application
- Start EPSON Scan from a TWAIN-compliant application

This section describes how to scan an image from EPSON Smart Panel. For details on the another way to start EPSON Scan, see Starting EPSON Scan.
Start EPSON Smart Panel.

See Starting EPSON Smart Panel

EPSON Smart Panel starts and the following window appears.

Click the Scan and Save icon on the EPSON Smart Panel.

Specify Location, File Name, and Image Format settings.
Click **Scan and Save** to start scanning or **Scan with Options** to change the scanning settings.

**File formats**

The following table lists some common image file formats. Select an appropriate format supported by your image processing application when you save image files.

<table>
<thead>
<tr>
<th>Format (File extension)</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP format (*.BMP) (Windows only)</td>
<td>BMP is a standard image file format in Windows. Most Windows applications including word processor applications can read and treat images in this format.</td>
</tr>
<tr>
<td>TIFF format (*.TIF)</td>
<td>TIFF is a file format which is designed for data exchange between applications such as graphics software and DTP software.</td>
</tr>
<tr>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>JPEG format (*JPG)</td>
<td>JPEG is a compressed file format, which allows a choice in compression quality. However, if the compression is too high, the image quality deteriorates. The image quality also deteriorates every time the image file is saved in JPEG. If you edit an image file after saving it, the original image should be preserved in a file format other than JPEG.</td>
</tr>
<tr>
<td>EPS format (*.EPS)</td>
<td>EPS is a PostScript file format. Most illustration and DTP applications are compatible with EPS.</td>
</tr>
<tr>
<td>PICT format (Macintosh only)</td>
<td>PICT is a standard image file format for Macintosh. Most Macintosh applications including word processor software can read and prepare images in this format.</td>
</tr>
<tr>
<td>PNG format (*.PNG)</td>
<td>PNG is a portable and highly-compressed file format designed for viewing in Web browsing applications, which allows a choice in compression quality. The image quality does not deteriorate when the image file is saved in PNG.</td>
</tr>
</tbody>
</table>
Placing Photos and Documents on the Document Table

Removing the document cover for thick or large documents

Before scanning a document, remember to respect the rights of copyright owners. Do not scan published text or images without first checking the copyright status.

Note:

- Keep the document table clean.
- You cannot scan films.

Open the document cover. Place the original document facing down on the document table. Make sure that the document is properly aligned.

Note:
- Make sure the document is flat against the glass surface; otherwise the image becomes out of focus.

- An area of up to 2.5 mm from the edge of the document table glass cannot be scanned.

Close the document cover gently so that the document does not move.

Note:

- To scan the document properly, close the document cover to prevent interference from external light sources.

- Do not leave photographs on the document table for an extended period of time. They may stick to the glass of the document table.

- Do not place heavy objects on top of this product.

- For a thick or large document, you can remove the document cover to make it easier to align the document. See Removing the document cover for thick or large documents.

Removing the document cover for thick or large documents

When you scan the thick or large document, you can remove the document cover.

Note:
- When you place a document without the document cover, press it down to make it flat.
- When you press the document, do not move it and do not add too much pressure.

**Removing and installing the document cover**

To remove the document cover, open the cover and pull it up.

When replacing the document cover, insert the tabs back into the slots.

⚠️ **Caution:**

- Do not use excessive force on the document cover, and do not twist it diagonally. Doing so may damage the document cover.
- Do not open and shut the scanner unit without the document cover. This may cause injury to the user or malfunction of the unit.
Choosing an Appropriate Scanning Mode

EPSON Scan provides three modes for you to make any scanning settings: Full Auto Mode, Home Mode, and Professional Mode.

**Full Auto Mode:**
The Full Auto Mode makes scanning simple, freeing you from complex settings or adjustments.

**Home Mode:**
The Home Mode enables you to adjust the basic image settings for scanned images.

**Professional Mode:**
In the Professional Mode, there are many options available to give you greater control over your scanning. You can sharpen, correct or enhance your images before scanning them in the Professional Mode.

The following table indicates the suitable mode to use according to the scanning purpose.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Full Auto Mode</th>
<th>Home Mode</th>
<th>Professional Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defining target size</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Optimizing brightness and color of image</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Removing moire patterns</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
<tr>
<td>Optimizing text or line art scanning</td>
<td>N/A</td>
<td>○</td>
<td>○</td>
</tr>
</tbody>
</table>
You can choose and change the scanning mode, as described in the following section.

**Changing the scanning mode**

You can change the scanning mode from the list box at the top right of the window.

Click the small arrow to the right of the list box, and then click to select a desired mode.

![EPSON Scan Mode Menu](image)

**Note:**

The scanning mode that was selected the last time you used EPSON Scan remains in effect when you start it again.
Making Suitable Settings

- For photos
- For text and line art
- For color documents
- For newspapers and magazines

For photos

Follow the steps below to make settings suitable for scanning photos (reflective documents) in the Professional Mode.

1. Place photos on the document table. If necessary, see the following section for more information.

   Placing Photos and Documents on the Document Table

2. Start EPSON Scan and then select the Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

3. The setting window appears. Specify the settings to match your document, referring to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Document Source</td>
<td>Document Table</td>
</tr>
<tr>
<td></td>
<td>Auto Exposure Type</td>
<td>Photo</td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Select a suitable image type.</td>
</tr>
</tbody>
</table>
Resolution
Select an appropriate resolution. See Select a suitable resolution.

Target Size
To be set in a later step.

Adjustments
To be set in a later step.

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images and then specify the Adjustments settings, if necessary. See *Creating Beautiful Reproductions* for details.
Click **Scan** to start scanning.

The scanned images are sent to the application or saved in the specified folder.

**Select a suitable resolution**

When you specify a high resolution, the number of pixels of the data increases and the scanned image becomes fine in texture. However, increasing the resolution causes the data size to increase. Specify a suitable resolution according to the scanning purpose.

The following table indicates the suitable resolution to use according to the scanning purpose.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending E-mail</td>
<td>96 to 150 dpi</td>
</tr>
<tr>
<td>OCR (Optical Character Recognition)</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Printing</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Filing</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Sending Fax</td>
<td>200 dpi</td>
</tr>
</tbody>
</table>

**For text and line art**

Follow the steps below to make settings suitable for scanning text and line art in Professional Mode. With this feature, outlines of text and line art are scanned and clearly defined. Clearly defined text can be reliably converted into text data using OCR software. See **Scanning Documents to Convert to Text Data (OCR)** for details.
Place a document on the document table.

Start EPSON Scan and then select the Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

The setting window appears. Specify the settings to match your document, referring to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Document Source</td>
<td>Document Table</td>
</tr>
<tr>
<td></td>
<td>Auto Exposure Type</td>
<td>Document</td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Black&amp;White is recommended.</td>
</tr>
<tr>
<td></td>
<td>Resolution</td>
<td>300 dpi for texts, 600 dpi for line arts</td>
</tr>
<tr>
<td></td>
<td>Target Size</td>
<td>To be set in a later step.</td>
</tr>
<tr>
<td>Adjustments</td>
<td></td>
<td>To be set in a later step.</td>
</tr>
</tbody>
</table>

4. Click the **Preview** button to preview the images.

5. Use **Target Size** to specify the output size of the scanned images and then specify the **Adjustments** settings, if necessary. See [Creating Beautiful Reproductions](#) for details.
Click **Scan** to start scanning.

The scanned images are sent to the application or saved in the specified folder.

---

**For color documents**

Follow the steps below to make settings suitable for scanning color documents in Professional Mode. With this feature, the use of colors on an original document is simplified to prevent the scanned image from being mottled. It is also suitable for modifying colors of an image with a color re-touching application.

1. **Place a document on the document table.**
   - [Placing Photos and Documents on the Document Table](#)

2. **Start EPSON Scan and then select Professional Mode.** For details on how to select a scanning mode, see **Changing the scanning mode**.

3. **The setting window appears.** Specify the settings to match your document, referring to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Source</td>
<td>Document Table</td>
<td></td>
</tr>
<tr>
<td>Auto Exposure Type</td>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Color Smoothing</td>
</tr>
</tbody>
</table>
Select an appropriate resolution. See Select a suitable resolution.

To be set in a later step.

To be set in a later step.

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images and then specify the Adjustments settings, if necessary. See Creating Beautiful Reproductions for details.
Click **Scan** to start scanning.

The scanned images are sent to the application or saved in the specified folder.

---

**For newspapers and magazines**

Follow the steps below to make settings suitable for scanning newspapers and magazines in Professional Mode. Using this feature, you can avoid a blank area being scanned as a yellowish image or images on the back side of paper being scanned through.

1. Place a document on the document table.
   
   Placing Photos and Documents on the Document Table

2. Start EPSON Scan and then select Professional Mode. For details on how to select a scanning mode, see Changing the scanning mode.

3. The setting window appears. Specify the settings to match your document, referring to the illustration and the table below.
<table>
<thead>
<tr>
<th>Original</th>
<th>Document Type</th>
<th>Reflective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document Source</td>
<td></td>
<td>Document Table</td>
</tr>
<tr>
<td>Auto Exposure Type</td>
<td></td>
<td>Document</td>
</tr>
<tr>
<td>Destination</td>
<td>Image Type</td>
<td>Select an appropriate image type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Select an appropriate resolution. See Select a suitable resolution.

Target Size
To be set in a later step.

Adjustments
To be set in a later step.

Click the **Preview** button to preview the images.

Use Target Size to specify the output size of the scanned images and then specify the Adjustments settings, if necessary. See *Creating Beautiful Reproductions* for details.

Click **Scan** to start scanning.
The scanned images are sent to the application or saved in the specified folder.
Creating Beautiful Reproductions

- Remove the moiré patterns from a scanned image
- Improve image sharpness
- Liven up the color on a scanned image
- Restore faded color images
- Enhance the quality of the scanned image (PRINT Image Matching)

EPSON Scan provides you with a variety of settings to improve the quality of a scanned image to satisfy your needs. You can easily adjust the quality of the image by selecting the box in the setting window. In this section, you will get the information on what you can do and how you do it.

Remove the moiré patterns from a scanned image

You can remove a wavy or ripped pattern called "moiré," which tends to happen in areas of halftone color such as skin color. Follow the steps below to remove these patterns.

Note:

- This feature is not available when the resolution is set to greater than 600 dpi.

- You cannot use this feature when Black&White is selected for Image Type.

- The result of removing moiré patterns does not apply to the previewed image.

Select the Descreening Filter check box in the Adjustments section. In Home Mode, open the Image Adjustments dialog box first to get to the Descreening Filter check box.
Select Screen Ruling appropriate for the image being scanned and your purpose. (In Home Mode, this function is not available.)

<table>
<thead>
<tr>
<th>Descreening Filter not applied</th>
<th>Descreening Filter applied</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Descreening Filter not applied" /></td>
<td><img src="image2.png" alt="Descreening Filter applied" /></td>
</tr>
</tbody>
</table>

**Improve image sharpness**

If the outline of the original edge of the image is not sharp enough, you can improve the sharpness of the scanned image by using this feature in Professional Mode. (This feature is automatically enabled in Home Mode.) Follow the steps below.

**Note:**

This feature is not available when **Color Smoothing**, **Halftone**, or **Black&White** is selected for Image Type.
Select the **Unsharp Mask Filter** check box in the Adjustments section.

![Unsharp Mask Filter](image)

Select the level of adjustments.

---

**Liven up the color on a scanned image**

You can liven up the color of a scanned image by adjusting the brightness of color, contrast, or color balance. Follow the steps below.

---

**Note:**
This feature is only available when you are scanning a color image.

1. Click the **Image Adjustment** button.

2. Adjust the items you want to change by sliding the tabs.
Close the Image Adjustment window by clicking the Close button.

**Restore faded color images**

Color Restoration is a scanner software feature that restores faded color on photos in Home or Professional Mode.

In Home Mode, click the Preview button to prescan your image, click the Image Adjustments button, then select the Color Restoration checkbox.
In Professional Mode click the **Preview** button to prescan your image, then scroll down and select the **Color Restoration** checkbox.

**Note:**

- Do not specify **8-bit Grayscale** for Image Type.

- Do not specify **Document** for Auto Exposure Type.

- Depending on the condition of photos, the color may not be restored as you desire.
Enhance the quality of the scanned image (PRINT Image Matching)

PRINT Image Matching is a standardized method of recording a wider range of color information to enhance the quality of your scanned images. Using this product with PRINT Image Matching, you can effortlessly achieve printouts that come to life with a dynamic range of brilliant colors.

**Note:**

PRINT Image Matching information does not change the image data or the way the image is displayed on a computer screen.

Follow the steps below to enhance the quality of your scanned images using EPSON Smart Panel.

1. Place your materials on the document table.

   **Placing Photos and Documents on the Document Table**

2. Start EPSON Smart Panel.

   **Starting EPSON Smart Panel**

   EPSON Smart Panel starts and the following window appears.
3. Click the **Scan and Save** icon on the EPSON Smart Panel.

4. Specify Location, File Name, and Image Format settings. Select **Print Image Matching II (JPEG)** or **Print Image Matching II (TIFF)** from the Type list box, and change the Photo Scene setting, if necessary.
Click **Scan and Save** to start scanning or **Scan with Options** to change scanning settings.


Scanning / Various Scanning Options

**Scanning Multiple Images Simultaneously**

You can simultaneously scan multiple photos and documents placed together on the document table as separate images.

**Note:**

Depending on the application, you may not be able to scan multiple images.

Follow the steps below to scan multiple materials using Professional Mode.

1. Place documents on the document table. See [Placing Photos and Documents on the Document Table](#) for details.

**Note:**

If you plan to preview images using the Thumbnail method, while scanning multiple photos, position each photo at least 20 mm apart from its adjacent photos.

2. Start EPSON Scan and then select Professional Mode. For details on how to select a scanning mode, see [Changing the scanning mode](#).

The following window appears.
Specify the Original and Destination settings to match your images.

Click the Preview button to preview the images.

Note:
You can select a preview method: Thumbnail Preview or Normal Preview. Click the small arrow to the right of the Preview button and then select Thumbnail or Normal.
In the Thumbnail Preview window:
EPSON Scan automatically locates the multiple photos, and then previews them as thumbnail images. Select the number check box of an image you want to scan.

Note:
Depending on the materials you want to scan, EPSON scan may not be able to automatically locate the target images, or preview the images as thumbnails. In this case, preview the images in the Normal Preview window.
In the Normal Preview window:
Create marquees on the previewed image to select an area you want to scan. You can create up to 50 marquees. For more details, see Using marquees.
When the output size of the scanned image is already decided, select an appropriate setting from the Target Size list. A marquee proportional to the measurements of the Target Size setting appears in the Preview window. You can move this marquee to the area of the image you want to scan. For more details, see the online help.

Specify the Adjustments settings, if necessary. (You may need to scroll to the bottom of the screen.)
Note:

For some settings, you can apply the same modifications to all of the images at once by clicking All. (In Normal Preview, you need to make marquees.) For detail, see Using marquees.

Click Scan. EPSON Scan starts scanning.

The scanned images are sent to the application or saved in the specified folder.
Scanning / Various Scanning Options

Scanning Documents to Convert to Text Data (OCR)

- Improve character recognition
- Potential text recognition problems

You can scan and convert documents to text data, and then edit them using with a word processing application. The technology that allows computers to "read" text from physical objects is called OCR. OCR requires a graphical representation of text to interpret, which usually comes from a scanned image.

1. Follow all of the steps described in For text and line art.

2. Import the scanned image into the OCR software.

Improve character recognition

Use the **Threshold** slider to change the threshold value, monitoring the results of the changes in the Preview window. Adjusting the threshold value can make it easier for OCR to recognize characters.

![Threshold slider](image)

**Note:**

The Threshold setting is available only when **Black&White** is selected for Image Type.
Potential text recognition problems

The quality of the text in your original document greatly affects the OCR results.

The following types of originals can make recognition difficult and should be avoided if possible:

- Items that have been copied from other copies
- Faxes
- Text with tightly-spaced characters or line pitch
- Text that is in tables or underlined
- Cursive or italic fonts, and font sizes less than 8 points

Remember that OCR software cannot recognize handwritten characters.
Starting Scanner Software (EPSON Scan) Directly

To save scanned images without editing them in an application, start EPSON Scan directly. After scanning images, the scanned images are automatically saved as files in the folder specified in the File Save Settings dialog box. This operation can be set up as follows:

Open the File Save Settings dialog box.

**For Windows users:**
Click Start, point to All Programs (for Windows XP users) or Programs (for Windows Me, 98, or 2000 users), point to EPSON Scan, and then select EPSON Scan.

**For Mac OS 9 users:**
Select EPSON Scan from the Apple menu.

**For Mac OS X users:**
Click the EPSON Scan icon in the Applications folder.
Specify a location where scanned images are saved. If you want to change the default location, click **Browse** (for Windows) or **Choose** (for Macintosh) and then select a desired folder.

Specify a file name with an alphanumeric character string (prefix) and a 3-digit number (start number).

If you want to change the file name, type an alphanumeric character string in the Prefix box and select a start number. The name of a file is generated using a combination of the prefix and number specified here.

**Note:**

If the **Show this dialog box before next scan** check box is cleared, the File Save Settings dialog box does not appear automatically. To open the dialog box, click the arrow to the right of the **Scan** button and then select **File Save Settings**.
For Windows users, the following characters cannot be used in the prefix.
\, /, :, .., *, ?,", <, >, |

For Macintosh users, you cannot use colon (:) in the prefix.

The number must be 3 digits. To save images using the MS -DOS 8.3 format, make sure the prefix does not exceed 5 alphanumeric characters.

Select a file format from the following table. Depending on the selected file format, the **Options** button may be available so that you can make detailed settings for scanned images.

<table>
<thead>
<tr>
<th>Format (File Extension)</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITMAP (*.BMP) (Windows only)</td>
<td>A standard image file format for Windows. Most Windows applications including word processing applications can read and prepare images in this format.</td>
</tr>
<tr>
<td>JPEG (*.JPG)</td>
<td>A compressed file format. The compression quality can be selected. The JPEG format enables relatively high compression ratio. However, the higher the compression ratio is, the lower the image quality becomes. (Note that the original data cannot be restored.) In addition, the quality deteriorates every time the data is saved. The TIFF format is recommended in cases where modification, retouch and like are required.</td>
</tr>
<tr>
<td>Multi-TIFF (*.TIF)</td>
<td>A TIFF format where multiple pages are saved to the same file. To open the Multi-TIFF files, you need an application supporting this format.</td>
</tr>
<tr>
<td>PDF (*.PDF)</td>
<td>A document format that is independent of platforms. To use PDF documents, you need Adobe Acrobat® Reader® or Acrobat. When you save color or grayscale images in PDF, you can select a compression quality.</td>
</tr>
<tr>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>PICT (*.PCT)</strong> (Macintosh only)</td>
<td>A standard image file format for Macintosh. Most Macintosh applications including word processing applications can read and prepare images in this format.</td>
</tr>
<tr>
<td><strong>TIFF (*.TIF)</strong></td>
<td>A file format created for exchanging data among many applications, such as graphic and DTP software. When scanning black &amp; white images, you can specify the compression type.</td>
</tr>
</tbody>
</table>

Click **OK**.

EPSON Scan starts scanning. The scanned image is automatically saved in the specified location.

If the **Open image folder after scanning** check box in the File Save Settings dialog box is selected, Windows Explorer (Windows) or Finder (Macintosh) automatically opens the folder where the scanned image is saved when EPSON Scan finishes scanning.
Using the Preview Window in EPSON Scan

Preview images

Before you scan an image, you can use the Preview window to see the effects of most EPSON Scan settings and make additional image adjustments.

Clicking the Preview button starts prescanning and previews the image. Depending on the scanning mode and the Document Type settings, a small arrow appears to the right of the Preview button, allowing you to select a preview method. Click the arrow and select Thumbnail or Normal to change the preview method.

Note:

- The preview window is not available in the Full Auto Mode.
- If the Auto preview check box is selected in the Home Mode main window, preview scanning automatically starts when you access the Home Mode.
- If there is no arrow to the right of the Preview button, EPSON Scan automatically uses the Normal Preview method when previewing an image.

Normal preview

The Normal Preview method allows you to see the entire previewed image and the effects of settings
you made, and to make additional image adjustments. You can also use marquees to scan selected portions of an image. For details on marquees, see Using marquees.

Click the **Zoom Preview** button to zoom in on a selected area of the image. Use a marquee to select the part of the image you want to zoom in and then click this button. An enlargement of the selection appears in the Zoom menu, allowing you to see the effects of your settings in more details.

**Note:**
When the output size of the scanned image is already decided, select an appropriate setting from the Target Size list. A marquee proportional to the measurements of the Target Size setting appears in the Preview window. You can move this marquee to the area of the image you want to scan. For more details, see the online help.

**Thumbnail preview**

The Thumbnail Preview method allows you to preview multiple images in a thumbnail layout. EPSON Scan automatically locates the target images and applies the Auto Exposure feature to each image. You can modify each thumbnail image and make additional image adjustments. You can also use marquees to scan selected portions of an image. For details on marquees, see Using marquees.
To scan an image that appears as a thumbnail, select the check box under the image you want to scan and then click **Scan**.

To modify a thumbnail image, click the image to select it and then choose the appropriate settings. The selected image has a blue frame around it.

To apply the same modifications to all of the thumbnail images at once, click **All**.

To enlarge a thumbnail image, select it and then click the **Full Size** tab. An enlargement of the selected image appears in the Full Size menu, allowing you to see the effects of your settings in more details.
Using marqueees

A marquee is a frame that you draw around a portion of a previewed image to select it.

**Normal Preview:**
You can make up to 50 marquees and apply them to select an area you want to enlarge using the **Zoom Preview** button.

**Thumbnail Preview:**
You can make only one marquee for one thumbnail image.

To create a marquee, move the pointer over the image in the Preview window. The pointer becomes a set of cross-hairs. Hold down the mouse button and drag the cross-hairs over an area of the image, and then release the mouse button to create the marquee.

The frame around the marquee appears as a moving dotted line, indicating that it is active and can be resized.

The point where you first clicked is anchored, but the rest of the frame is sizable and movable.
When the mouse pointer is placed within the marquee (the frame of the selected image area), it changes to a hand. You can click and drag the marquee anywhere in the Preview window. If you drag the hand pointer while pressing the **Shift** key, the marquee becomes restricted to the vertical or horizontal movement.

When the mouse pointer is placed on the edge of the marquee, it changes to an arrow, allowing you to resize the marquee. If you drag the arrow pointer while pressing the **Shift** key, the marquee is resized proportionally.
To remove or delete a marquee, click the marquee and then click the **Delete marquee** button.
Overview of EPSON Smart Panel

Starting EPSON Smart Panel

EPSON Smart Panel allows you to scan and send data directly to an assigned application or the EPSON photo-sharing site. You can also obtain photos and documents in digital form quickly and easily.

When you install the CX3500/CX4500 software, EPSON Smart Panel is also installed at the same time. See the Start Here sheet for more information.

Note:

If you use the EPSON Photo Site feature, you can scan images using PRINT Image Matching. For the detailed procedure on how to scan images using the PRINT Image Matching method, see Enhance the quality of the scanned image (PRINT Image Matching).

Note for Windows 98 users:

EPSON Smart Panel supports Windows 98 Second Edition or later.

PRINT Image Matching

PRINT Image Matching is a standardized method of recording a wider range of color information to enhance the quality of your scanned images. When you use the EPSON Photo Site feature, PRINT Image Matching information is recorded in the resulting JPEG or TIFF image files. Then, by using an application and printer compatible with PRINT Image Matching, you can effortlessly achieve printouts that come to life with a dynamic range of brilliant colors.

Note:

PRINT Image Matching information does not change the image data or the way the image is displayed on a computer screen.

Starting EPSON Smart Panel

Follow the steps below to start EPSON Smart Panel.
For Windows users:
Click Start, point to All Programs (for Windows XP users) or Programs (for Windows Me, 98, or 2000 users) and then EPSON Smart Panel, then click EPSON Smart Panel.

For Mac OS 9 users:
Select EPSON Smart Panel from the Apple menu.

For Mac OS X users:
Double-click the Applications folder in the Macintosh HD, and then double-click the Smart Panel folder. Finally, double-click the EPSON Smart Panel icon.

The EPSON Smart Panel window appears.

To access an application, click its application icon in the window. See Applications in the EPSON Smart Panel Window for details about the applications available. For details, refer to the EPSON Smart Panel online help.
Applications in the EPSON Smart Panel Window

- Scan and Save
- Copy Center
- Copy to Fax
- Scan to Application
- Scan to E-mail
- EPSON Photo Site

Scan and Save

Use this option to scan, convert, and then save an image to a specific folder. You can also convert an image using the PRINT Image Matching standard and add various color effects to the scanned image. When you click Scan and Save icon, the following dialog box appears. Click **Scan and Save** to start scanning or **Scan with Options** to change scanning settings.

![Scan and Save dialog box](image)

**Note:**

For information on the PRINT Image Matching technology, see [PRINT Image Matching](#).
Copy Center

Use this option to turn your scanner into a digital copy machine, with functions far more powerful and flexible than conventional copy machines. You can scan and then print images as photos, copy in various sizes, or place several photos on the same page. Before you print an image, you can see the effects of image adjustments using the Preview window. When you select **Copy/Reprint Photos**, the following screen appears.

![Copy Utility](image)

Copy to Fax

**Note:**

This option is available when a fax application is installed on your computer.

Use this option like a fax machine, to scan an image on the document table and send it by fax using a fax...
application. When you select **Copy to Fax**, the Copy Utility screen appears. Images scanned using the Copy Utility are sent to the fax application.

### Scan to Application

Use this option to scan and then send images to a desired application for further editing. When you select **Scan to Application**, the following screen appears and the image is scanned from EPSON Scan.

![Scan To Application Screen](image)

### Scan to E-mail

Use this option to scan an image and send it in an e-mail message. When you select **Scan to E-mail**, the following screen appears and the image is scanned from EPSON Scan.
EPSON Photo Site

Use this option to scan an image using the PRINT Image Matching technology, and then upload it to the EPSON photo-sharing site. When you select **Epson Photo Site**, the image is scanned from EPSON Scan and displayed in the Verify Assistant dialog box. Click **Next**. You see the following dialog box.
Click **Upload** to upload the image.

**Note:**

For information on PRINT Image Matching technology, see [PRINT Image Matching](#).
Updating your OS

If you are using this product with a computer which you are planning to upgrade with a new operating system, follow the instructions below.

If the printer driver and EPSON Scan are already installed, you need to uninstall them, upgrade your system, and then re-install the printer driver and EPSON Scan, as follows:

1. Uninstall the printer driver and EPSON Scan before upgrading your system. See Uninstalling the Printer Software and Uninstalling EPSON Scan.

2. After uninstalling the printer driver and EPSON Scan, turn off the computer, and make sure this product is unplugged and disconnected from the computer.

3. Turn on the computer and install the new operating system.

4. Make sure the operating system is installed correctly, and then shut down your computer.

5. Install the printer driver and EPSON Scan, then connect this product following the instructions on your Start Here sheet.
Updating the Printer Software for Windows Me, XP, or 2000

When you update the printer software in Windows Me, XP, and 2000, be sure to uninstall the previous printer software before you install the new software. Installing over the existing printer software results in a failure to update. See Uninstalling the Printer Software.
Uninstalling the Printer Software

For Windows

Note:

- To uninstall software programs under Windows 2000, it is necessary to log on as a user with administrative privileges (a user who belongs to the Administrators group).

- To uninstall applications in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot uninstall applications if you log on as a Limited account user.

Turn off this product and disconnect it from the computer.

In Control Panel in Windows, double-click the Add/Remove Programs icon (Windows Me, 98, or 2000) or the Add or Remove Programs icon (Windows XP).

Select EPSON Printer Software from the list, then click Add/Remove (Windows Me or 98) or Change/Remove (Windows XP or 2000).

Select the EPSON Stylus CX3500 or EPSON Stylus CX4500 icon and click OK.

Click OK.

Note:
If you are using the USB port to connect this product in Windows Me or 98, you need to uninstall an additional USB component. Select **EPSON USB Printer Device** from the list in the Add/Remove Programs utility, click the **Add/Remove** button, and then click **OK** when a message prompts you to restart the computer. If **EPSON USB Printer Device** does not appear in the Add/Remove Programs list, double-click **EPUSBUN.EXE** on the software CD-ROM, and then follow the on-screen instructions.

**For Macintosh**

**For Mac OS 9**

1. Quit all applications.

2. Insert the EPSON printer software CD-ROM into your Macintosh.

3. Open the **Drivers** folder, then the **OS9** folder, then the **Printer** folder.

4. Double-click the **Installer** icon.

5. Click **Continue**. When the software license agreement screen appears, read the statement and then click **Accept**.

6. Select **Uninstall** from the menu at the upper left, and click **Uninstall**.

7. Follow the on-screen instructions.

**For Mac OS X**
1. Quit all applications.

2. Insert the EPSON printer software CD-ROM into your Macintosh.

3. Double-click the Mac OS X folder.

4. Double-click the Drivers folder, then double-click the Printer folder.

5. Double-click the CX3500 or CX4500 icon.

   **Note:**
   If the Authenticate dialog box appears, enter the Password or phrase, then click OK.

6. When the software license agreement screen appears, read the statement and then click Accept.

7. Select Uninstall from the menu at the upper left, and click Uninstall.

8. Follow the on-screen instructions.

   **Note:**
   If the printer name remains in the Print Center or Printer Setup Utility after uninstalling the printer software, delete your printer name from the Print Center or Printer Setup Utility. Open the Print Center or Printer Setup Utility, select the printer name from Printer List, and then click Delete.
Uninstalling EPSON Scan

For Windows

Note:

- You can also uninstall EPSON Scan from the EPSON Installation Program dialog box. To view the dialog box, insert the software CD in the CD-ROM drive.

- To uninstall software programs under Windows 2000, it is necessary to log on as a user with administrative privileges (a user who belongs to the Administrators group).

- To uninstall applications in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot uninstall applications if you log on as a Limited account user.

1. Turn off this product and disconnect this product from the computer.

2. In Control Panel in Windows, double-click the Add/Remove Programs icon (for Windows Me, 98, or 2000 users) or the Add or Remove Programs icon (for Windows XP users).

3. Select EPSON Scan from the list, then click Add/Remove (for Windows Me or 98 users) or Change/Remove (for Windows XP or 2000 users).

4. A confirming dialog box appears. Click Yes.
Follow the on-screen instructions.

6 Click **Finish** to complete the uninstallation. In some cases, a message may appear to prompt you to restart the computer; make sure **Yes, I want to restart my computer now** is selected and then click **Finish**.

For Macintosh

For Mac OS 9

1 Turn on your Macintosh and insert the software CD into the CD-ROM drive.

2 Double-click the **EPSON Scan** folder and double-click the **EPSON Scan Installer** icon in your preferred language folder.

3 Click **Accept**. The Installer dialog box appears.

4 Select **Uninstall** from the pull-down menu at the top left, and then click **Uninstall**.
For Mac OS X

1. Turn on your Macintosh and insert the software CD into the CD-ROM drive.

2. Double-click the **Mac OS X Driver** folder.

3. Double-click the **EPSON Scan** folder, and then double-click your preferred language folder.

4. Double-click the application folder you want to uninstall, and then double-click the installer icon.

   If the Authenticate window opens, click the key icon, enter the administrator's name and password, click **OK**, and then click **Continue**.

5. Click **Accept**. The Installer dialog box appears.

6. Select **Uninstall** from the pull-down menu at the top left, and then click **Uninstall**.
Uninstalling the Reference Guide

For Windows

Note:

- To uninstall software programs under Windows 2000, it is necessary to log on as a user with administrative privileges (a user who belongs to the Administrators group).

- To uninstall applications in Windows XP, it is necessary to log on with a Computer Administrator account. You cannot uninstall applications if you log on as a Limited account user.

Turn off this product and disconnect it from the computer.

Open the Control Panel and double-click the Add/Remove Programs icon (in Windows Me, 98, or 2000) or the Add or Remove Programs icon (in Windows XP).

Select EPSON Stylus CX3500/CX4500 Reference Guide from the list, then click Add/Remove (in Windows Me or 98) or Change/Remove (in Windows XP or 2000).

Click OK.

Note:
If you are using a USB port to connect this product in a Windows Me or 98 environment, you also need to uninstall a USB component. Select **EPSON USB Printer Devices** from the list in the Add or Remove Programs utility, click **Change/Remove** or **Add/Remove**, then click **OK** when a message prompts you to restart the computer. If **EPSON USB Printer Devices** does not appear in the Add or Remove Programs list, double-click **EPUSBUN.EXE** on the printer software CD-ROM, then follow the on-screen instructions.

**For Macintosh**

Drag the **cx3500_e** or **cx4500_e** folder in the **Epson** folder in the **Applications** folder on your hard drive to the Trash.
Troubleshooting / Printing and Copying Problems

Canceling Printing

- Using the Stop button on the control panel
- For Windows XP and 2000
- For Windows Me and 98
- For Mac OS 9
- For Mac OS X

If you encounter problems while printing, you may need to cancel printing. To cancel printing, follow the instructions in the appropriate section below.

**Using the Stop button on the control panel**

To cancel a print job, press the **Stop** button.

**For Windows XP and 2000**

When you send a print job to this product, the Progress Meter appears on your computer screen.
Click the **Stop** button to cancel printing.

---

**For Windows Me and 98**

It is possible to cancel printing using either the Progress Meter or EPSON Spool Manager. Refer to the appropriate section below.

**Using the Progress Meter**

When you send a print job to this product, the Progress Meter appears on your computer screen.
Click the **Stop** button to cancel printing.

**Using EPSON Spool Manager**

EPSON Spool Manager is similar to Windows Print Manager. If it receives two or more print jobs at one time, it holds them in the order that they were received (with printers on a network this may be called a print queue). When a print job reaches the top of the line, the EPSON Spool Manager sends the job to the printer. From the Spool Manager, you can cancel print jobs. You can also view print status information about the print jobs which have been sent to this product, as well as pause and resume selected print jobs.

After you send a print job, an **EPSON Stylus CX4600** button appears on the taskbar. Click this button to open the EPSON Spool Manager.
To cancel a print job, select the job in the list, then click **Cancel**.

---

**For Mac OS 9**

The procedure for canceling printing for Macintosh varies depending upon whether background printing is on or off. Refer to the appropriate section below.

**When background printing is on**

Follow the steps below to cancel a print job.

1. Select **EPSON Monitor IV** from the application menu.

2. Press the **Stop** button to stop printing.
In the Document Name list, select the document which is printing, then click the Delete icon button to cancel the print job.

**When background printing is off**

Follow the steps below to cancel a print job.

1. Press the Stop button to stop printing.

2. Hold down the command key on your keyboard and press the period (.) key to cancel the print job.

**For Mac OS X**
Follow the steps below to cancel a print job.

1. Click the Print Center or Printer Setup Utility icon in Dock.

2. Press the Stop button to stop printing.

3. In the Printer List, double-click Stylus CX4600.

4. In the Document Name list, select the document which is printing, and then click the Delete button to cancel the print job.
# USB Interface

<table>
<thead>
<tr>
<th>Standard</th>
<th>Based on Universal Serial Bus Specifications Revision 2.0, Universal Serial Bus Device Class Definition for Printing Devices Version 1.1, Universal Serial Bus Mass Storage class Bulk-Only Transport Revision 1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit rate</td>
<td>12 Mbps (full speed device)</td>
</tr>
<tr>
<td>Data encoding</td>
<td>NRZI</td>
</tr>
<tr>
<td>Adaptable connector</td>
<td>USB Series B</td>
</tr>
<tr>
<td>Recommended cable length</td>
<td>Under 2 m</td>
</tr>
</tbody>
</table>
Troubleshooting / Printing and Copying Problems

Print Quality Problems

- Horizontal banding
- Vertical misalignment or banding
- Incorrect or missing colors
- Blurry or smeared printout
- Print quality does not improve after head cleaning

If you are having print quality problems, first perform a Test Printing. Then, compare your test printing with the illustrations below. Click the caption under the illustration that best resembles your printout.

<table>
<thead>
<tr>
<th>enthält ein Aufdruck. W 008 &quot;Regel:</th>
<th>enthält ein Aufdruck. W 008 &quot;Regel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal banding</td>
<td>Vertical misalignment or banding</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>enthält ein Aufdruck. W 008 &quot;Regel:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal banding</td>
</tr>
<tr>
<td>Vertical misalignment or banding</td>
</tr>
</tbody>
</table>
Blurry or smeared printout  Incorrect or missing colors

**Horizontal banding**

Try one or more of these solutions:

- Make sure that the printable side of the paper is face up in the sheet feeder.

- Run the Head Cleaning utility to clear any clogged ink nozzles. See "Cleaning the Print Head" in the Quick Reference Guide.

- Clear all customized settings, and then select the **Text & Image** setting under Quality Option on your printer software's Main menu (Windows) or select the **Automatic** setting under Mode in the Print dialog box (Macintosh).

- Check the ink level using the printer software. See Checking the Ink Supply. If the Ink light is on, replace the appropriate ink cartridge. See Replacing an Empty Ink Cartridge.

- Make sure that the Media Type selected in the printer software is appropriate for the type of media loaded in this product.

**Vertical misalignment or banding**

Try one or more of these solutions:

- Make sure that the printable side of the paper is face up in the sheet feeder.

- Run the Print Head Alignment utility. See Aligning the Print Head.
Clear the **High Speed** check box in the Advanced dialog box.

Run the Head Cleaning utility to clear any clogged ink nozzles. See "Cleaning the Print Head" in the Quick Reference Guide.

Make sure that the Media Type setting selected in the printer software is appropriate for the type of media loaded in this product.

### Incorrect or missing colors

Try one or more of these solutions:

- When **Draft** is selected as the Quality Option setting on the printer driver's Main menu (Windows), as the Print Quality setting in the Advanced dialog box (Mac OS 9), or as the Print Quality setting in the Print dialog box under Print Settings (Mac OS X), other colors of ink are mixed with black ink to create the printout even if printing a black and white document. If you are not satisfied with the print results, please select an option other than **Draft**.

- Change the Color setting in the printer software to **Color**.

- Adjust the color settings in your application or in the printer software's Advanced dialog box.

- Run the Head Cleaning utility. See "Cleaning the Print Head" in the Quick Reference Guide. If colors are still incorrect or missing, replace the color ink cartridge. If the problem persists, replace the black ink cartridge. See "Replacing an Ink Cartridge" in the Quick Reference Guide.

- Do not use ink cartridges beyond the expiration data printed on the cartridge package. Also, if this product has not been used for a long time, replace the ink cartridges. See **Replacing an Empty Ink Cartridge**.

### Blurry or smeared printout

Try one or more of these solutions:
● Make sure that you are using the appropriate printer driver for this product.

● Use only paper recommended by Epson. See Media Type Settings.

● Make sure that this product sits on a flat, stable surface that extends beyond this product base in all directions. This product will not operate properly if it is tilted.

● Make sure that your paper is not damaged, dirty, or too old. Also, make sure that the printable side of the paper is face up in the sheet feeder.

● Make sure that your paper is dry and that the printable side is facing up. Also, make sure that you are using an acceptable paper type. See Paper.

● Clear all customized settings, and then select the Text & Image setting under Quality Option on your printer software's Main menu (Windows) or select the Automatic setting under Mode in the Print dialog box (Macintosh).

● If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.

● Set the adjust lever to the position, and make sure that the Media Type setting in your printer driver is correct. Continue printing even if an alert appears on the screen when setting the adjust lever to the position.

● If printing on Epson Photo Quality Ink Jet Paper, select a setting other than Best Photo under Quality Option on your printer software's Main menu or the Advanced dialog box (Windows), or move the slider to Speed when Automatic is selected under Mode in the Print dialog box (Macintosh).

● Remove each sheet from the output tray as it is printed.

● If you are printing on glossy media, place a support sheet (or a sheet of plain paper) beneath the stack. Or, load only one sheet at a time.

● Do not touch or allow anything to come into contact with the printed side of paper with shiny finishes. After printing, documents that are printed on glossy media should not be handled for a few hours to allow the ink to set.

● Run the Head Cleaning utility. See "Cleaning the Print Head" in the Quick Reference Guide.

● Run the Print Head Alignment utility. See Aligning the Print Head.
- Make several copies without placing a document on the document table. If the problem persists, ink may have leaked inside this product, so wipe the inside of this product with a soft, clean cloth.

**Warning:**

Be careful not to touch the gears inside this product.

**Caution:**

Be careful not to wipe the carriage shaft.

Print quality does not improve after head cleaning

If the quality of your printouts remains poor even after repeatedly cleaning and aligning the print head, one or some of the ink cartridges may be old or damaged and should be replaced.

To replace an ink cartridge before the Status Monitor notifies you that the cartridge is empty, see [Replacing an Empty Ink Cartridge](#).
Troubleshooting / Printing and Copying Problems

Printout Problems Not Related to Print Quality

- Incorrect or garbled characters
- Incorrect margins
- Inverted image
- Blank pages print
- Printout has smears on the bottom edge
- Printing is too slow

Incorrect or garbled characters

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for this product.
- Select this product as the default printer in Windows.
- In Windows Me and 98, clear any stalled print jobs from the Spool Manager. See Using EPSON Spool Manager.
- Turn off this product and computer. Make sure that the USB cable is securely plugged in.

Incorrect margins

Try one or more of these solutions:

- Check the margin settings in your application. Make sure that the margins are within the printable area of the page. See Paper.
- Check the settings on the Main menu (Windows) or in the Page Setup dialog box (Macintosh). Make sure the settings are appropriate for the paper size you are using.
**Inverted image**

Clear the Mirror Image check box in the printer software or turn off the "Mirror Image" setting in your application. For instructions, see online help for the printer software or for your application.

**Blank pages print**

Try one or more of these solutions:

- Make sure that you are using the appropriate printer driver for this product.

- In Windows, make sure this product is selected as the default printer.

- Check the settings on the Main menu (Windows) or in the Page Setup dialog box (Macintosh). Make sure the settings are appropriate for the paper size you are using.

- Run the Head Cleaning utility to clear any clogged nozzles. See "Cleaning the Print Head" in the Quick Reference Guide.

After trying one or more of these solutions, run a printer operation check to check your results. See Running a printer operation check.

**Printout has smears on the bottom edge**

- If the paper is curled toward the printable side, flatten it or curl it slightly toward the opposite side.

- Set the adjust lever to the position. After printing, return the adjust lever to the position.
Printing is too slow

Try one or more of these solutions:

- Make sure that the Media Type setting in your printer software is correct.

- For Windows, select the **Text** setting under Print Quality on your printer software's Main menu. See online help for details.

  For Macintosh, select the **Automatic** setting under Mode in the Print dialog box and then move the slider to **Speed**. See online help for details.

- Close any applications that you are not using at the moment.

- If you upgraded from Windows 95 to Windows 98, uninstall the printer software using Add/Remove programs in the Control Panel, then install the software again.
Troubleshooting / Printing and Copying Problems

Paper Does Not Feed Correctly

- Paper does not feed
- Multiple pages feed
- Paper jams
- Paper improperly loaded
- Paper is not ejected fully or is wrinkled
- Paper does not feed correctly when using the double-sided printing feature

Paper does not feed

Remove the stack of paper and make sure of the following:

- The paper is not curled or creased.
- The paper is not too old. See the instructions that came with the paper for more information.
- The paper stack fits under the tabs inside the edge guides and does not exceed the loading limit indicated by the arrow mark on the left edge guide.
- The number of sheets in the paper stack does not exceed the limit specified for the media. See Paper specifications.
- Paper is not jammed inside this product. If it is, remove the jammed paper. See Paper jams.
- The ink cartridges are not empty. Replace cartridges as necessary. See Replacing an Empty Ink Cartridge.

After trying the solutions above, load the paper again. Make sure that you follow any special loading instructions that came with your paper. See also Paper specifications.

Multiple pages feed
Make sure that the paper stack fits under the arrow mark located on the inside surface on the left edge guide.

Make sure that the paper stack is flush with or lower than the triangular load-limit mark on the edge guide.

Make sure that the left edge guide is snug to the left edge of the paper.

Make sure that the paper is not curled or folded. If it is, flatten it or curl it slightly toward the opposite side.

Remove the stack of paper and make sure that the paper is not too thin. See Paper.

Fan the edges of the stack to separate the sheets, then reload the paper.

If too many copies of a document are being printed, check the Copies setting on the printer software's Page Layout menu (Windows) or in the Print dialog box (Macintosh) and in your application. See online help for details.

---

**Paper jams**

If paper is jammed inside this product, the Error light on the operation panel flashes. You may be able to clear the jammed paper using the Control Panel. Follow the steps below.

1. Press the Start Color button to eject the jammed paper. If the jammed paper is not ejected, go on to the next step.

2. Locate where the paper is jammed.

   **If the paper is jammed at the paper feeding position or the ejecting position**, remove all of the paper by hand.

   **If the paper is jammed inside this product**, press the On button to turn off this product. Open the scanner unit, and then remove all of the paper inside by hand, including any torn pieces.
After clearing the jammed paper, close the scanner unit and then press the On and the Start Color button.

Load a stack of paper in the sheet feeder.

**Note:**

If you cannot remove a foreign object easily by yourself, do not use force and do not disassemble this product. Call your dealer for assistance.

If your paper jams frequently, make sure of the following:

- The paper is smooth, not curled or wrinkled.
- The paper is of high quality.
- The printable side of the paper is face up in the sheet feeder.
- The paper stack was fanned before loading.
- The paper is not loaded above the arrow on the left edge guide.
- The paper stack fits under the tabs inside the edge guides.
- The number of sheets in the paper stack does not exceed the limit specified for that media. See Loading capacities for Epson special media.
- The left edge guide is adjusted to fit your paper.
- This product is on a flat, stable surface that extends beyond this product base in all directions. This product will not operate properly if it is tilted.

**Paper improperly loaded**

If you have loaded the paper too far into this product, it cannot feed the paper correctly. Turn this
product off and gently remove the paper. Then turn it on and reload the paper properly.

Paper is not ejected fully or is wrinkled

Try one or more of these solutions:

- Clear the jammed paper as explained in Paper jams. Also, check the Paper Size setting in your application or printer software.

- If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack.

Note:

Store any unused paper in its original package in a dry area. See Paper.

Paper does not feed correctly when using the double-sided printing feature

If multiple pages feed when using the double-sided printing feature, remove the paper as instructed in Multiple pages feed. If the paper that was fed in error has not been creased or wrinkled, it may still be usable. Reload only the usable paper properly into this product.

If a paper jam should occur while using the double-sided printing feature, remove the paper as instructed in Paper jams. If multiple print jobs have been sent to the printer when the paper jam occurs, check the page settings in your application and confirm that the paper is loaded properly to ensure that no pages are skipped and that the document is printed correctly.
This Product Does Not Print

- All lights are off
- Lights came on and then went out
- The Error light is on

All lights are off

Try one or more of these solutions:

- Press the On button to make sure that this product is on.
- Turn off this product and make sure the power cord is securely plugged in.
- Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights came on and then went out

This product's voltage may not match the outlet rating. Turn off this product and unplug it immediately. Then, check the product's label voltage.

Caution:

If the voltage does not match, DO NOT PLUG YOUR PRODUCT BACK IN. Contact your dealer.

The Error light is on

Try one or more of these solutions:
● Check EPSON Status Monitor 3 (Windows) or EPSON StatusMonitor (Macintosh) to find the cause of the error.

● Check the Error light. For details of error indicators, see the Quick Reference Guide.
Troubleshooting / Scanning Problems

Scanner Operation Problems

- This product does not scan
- Pressing the buttons on the control panel does not start scanning
- Pressing the buttons on the control panel in a Mac OS X environment starts Classic mode
- You cannot scan multiple images

Problems you may have while using this product often involve the operation of your software and computer. Operation problems usually occur because of:

- Incorrect setup of the interface (see your Start Here sheet).
- Incorrect setup of your computer or software (see your Start Here sheet).
- Incorrect operation of your software (see your software documentation).

Also see the documentation that came with your computer for possible solutions.

This product does not scan

For Windows

Note the following:

- You cannot scan when any one of the lights is flashing.
- Your system may not work properly if you do not use a USB cable that meets the specifications for this product's USB interface.
- This product may not work properly when connected to the computer through more than one hub. In this case, connect this product directly to the computer's USB port, or through one hub.
Pressing the buttons on the control panel does not start scanning

Try one or more of these solutions:

- Make sure EPSON Smart Panel is installed.

- **For Windows XP users:**
  Click the **Events** tab in this product's Properties dialog box and make sure **Take no action** is not selected. Also, make sure **Scan Button** is selected in the Select an event list box, and **Start this program** is selected.

- **For Windows Me, 98, and 2000 users:**
  Click the **Events** tab in this product's Properties dialog box and make sure the **Disable device events** check box is clear. Also, make sure **Scan Button** is selected in the Scanner events list box, and the desired application in the Send to this application list is selected.

- **For Mac OS X users:**
  - When in Classic mode, the buttons are disabled. Quit Classic mode.
  - Initially, only the user who installed the scanner software can scan using the buttons. Other users must start EPSON Scanner Monitor in the Applications folder before using the buttons for the first time. From then on, pressing a button will automatically start the application assigned to it.

Pressing the buttons on the control panel in a Mac OS X environment starts Classic mode

Try one or more of these solutions:

- Be sure to install the scanner software in a Mac OS X environment, and not in Classic mode.

- If EPSON Smart Panel has been installed in Mac OS 9, uninstall it and make sure EPSON Smart Panel is installed in Mac OS X.
You cannot scan multiple images

Try one or more of these solutions:

- Position each photo at least 0.8 inch (20 mm) apart from adjacent photos.

- Make sure your application is available to scan multiple images.
Troubleshooting / Scanning Problems

Software Operation Problems

- You cannot start EPSON Scan
- The scanner software does not work properly

You cannot start EPSON Scan

Try one or more of these solutions:

- Turn on this product and then turn on the computer.

- Turn off this product and the computer. Then check the connection between this product and the computer.

- Make sure that EPSON Scan is selected in your application software.

- Make sure your software is installed correctly.

- In the Device Manager menu, make sure this product's name appears under Imaging devices hardware type without a question (?) or an exclamation (!) mark. If this product appears with a question (?) or an exclamation (!) mark, or as an Unknown devices hardware type, uninstall EPSON Scan. Then reinstall it following the instructions on your Start Here sheet.

The scanner software does not work properly

Try one or more of these solutions:

- Make sure your software is installed correctly.

- For Windows XP and Me users:
  Check if this product's icon appears more than once. To check, double-click the Scanners and Cameras icon in Control Panel in Windows. Remove this product's icon from the window, then reinstall EPSON Scan following the instructions on your Start Here sheet.
For Windows 98 and 2000 users:
Check if this product is listed more than once in the Scanners and Cameras Properties dialog box. To view the dialog box, double-click the Scanners and Cameras icon in the Control Panel. Remove this product from the list of installed devices, then reinstall EPSON Scan following the instructions on your Start Here sheet.

- Make sure your computer meets the memory and other system requirements specified for the software you are using.

- Make sure the computer has enough memory for your software. If the computer does not have enough memory available, see your software and computer documentation for details.
Troubleshooting / Scanning Problems

Quality Problems

- Edges of the document are not scanned
- You cannot scan an image or you only get a few dots for the scanned image
- The image does not look the same as the original
- A line of dots is always missing from the scanned image
- A line of dots always appears in the scanned image
- Straight lines in the image come out jagged
- Scanned image by using the buttons on the control panel is missing
- The entire image is distorted or blurred
- Part of the image is distorted or blurred
- Colors are patchy or distorted at the edges of the image
- The image is faint or out of focus
- The image is too dark
- Image is dark, with little or no detail
- Scanned image is too large
- Moiré (cross-hatch) patterns appear in the scanned image
- Poor character recognition during OCR scanning
- The printed image is larger or smaller than the original
- Scanned images cannot be printed or come out garbled when printed
- Images cannot be located properly in the Thumbnail preview

Edges of the document are not scanned

Try one or more of these solutions:

- Make sure the document is aligned with the alignment mark. See Placing Photos and Documents on the Document Table.

- Position the document so the area you want to scan is within the edge guide limits of the document table. The area with a width of maximum 2.5 mm from both the horizontal and vertical guides is not scanned.
You cannot scan an image or you only get a few dots for the scanned image

Try one or more of these solutions:

- Make sure the document is placed on the document table.

- Change the Threshold setting in the Image Control dialog box. Select Text/Line Art as the Image Type, and then change the Threshold setting in the Image Control dialog box.

The image does not look the same as the original

Try one or more of these solutions:

- Try different image setting combinations on your scanner software.

- Your software may not have sufficient color matching and color management features, or these components may not be installed correctly. See the documentation that comes with your software and computer.

- If you are importing an image file, make sure the file format is one your software can read. Also, make sure the image settings of your software are appropriate for the type of scanned image.

A line of dots is always missing from the scanned image

Scanner sensor malfunction is indicated when a line is missing on both screen images and printouts. Contact your dealer.

A line of dots always appears in the scanned image

If this happens on both your screen and printout, the document table may be dusty or scratched. Clean
the paper path guide or clean the document table. If the problem still exists the guide may be scratched and require replacement.

Straight lines in the image come out jagged

Make sure the document orientation is perfectly straight on the document table. Align vertical and horizontal lines with the scales at the top and side of the document table.

Scanned image by using the buttons on the control panel is missing

Make sure desired application is assigned to the buttons on the control panel.

The entire image is distorted or blurred

Try one or more of these solutions:

- Make sure the document is flat against the document table.

![Caution:](https://via.placeholder.com/150)

Do not place heavy objects on the document table.

- Make sure you do not accidentally move the document during scanning.

- Make sure this product is on a flat, stable surface.

Part of the image is distorted or blurred
Make sure the document is uniformly flat against the document table. A document that is wrinkled or warped may not scan well.

⚠️ **Caution:**

Do not place heavy objects on the document table.

---

**Colors are patchy or distorted at the edges of the image**

Try one or more of these solutions:

- A document that is very thick or warped at the edges can cause discoloration. Cover the edges of the document with paper to block outside light.

- Make sure the document is flat against the document table.

⚠️ **Caution:**

Do not place heavy objects on the document table.

---

**The image is faint or out of focus**

Try one or more of these solutions:

- Make sure the document is flat against the document table.

⚠️ **Caution:**

Do not place heavy objects on the document table.

- Adjust your software's Exposure setting using the Auto Exposure button in the Professional Mode.
Adjust your software's Gamma setting using the Histogram Adjustment dialog box in the Professional Mode.

The image is too dark

Try one or more of these solutions:

- Check your software's Brightness setting using the Image Adjustment tools in the Home Mode or the Histogram Adjustment dialog box and the Image Adjustment dialog box in the Professional Mode.

- Check the brightness and contrast settings of your computer display.

Image is dark, with little or no detail

Try one or more of these solutions:

- Change the Display Gamma setting. See online help for details.

- Change the Destination setting in the Home Mode or the Professional Mode main window.

- In the Home Mode, select **Screen/Web** as the Destination. Selecting a printer may cause on-screen colors to be different from the colors of the original; however, colors will be reproduced correctly when the image is printed.

Scanned image is too large

Change the Target Size setting of the Destination setting in the Home Mode or the Professional Mode main window.
Moiré (cross-hatch) patterns appear in the scanned image

A moiré is a cross-hatch pattern that appears on the scanned images when scanning printed materials. It is a result of interference that occurs due to the difference between the pitches of the scanning and the halftone screens.

Try one or more of these solutions:

- Check the Descreening Filter check box in the Home Mode or the Professional Mode main window.

- In the Professional Mode, set the Screen Ruling of the Descreening Filter setting to the appropriate setting for your document.

- Place a transparent sheet such as an overhead projector sheet, between the document and the document table.

- Reposition the document slightly.

- Make the image size slightly smaller.
Poor character recognition during OCR scanning

Try adjusting the Threshold setting. See Scanning Documents to Convert to Text Data (OCR) for more information.

The printed image is larger or smaller than the original

The image size and resolution settings of your software determine the size of the printed image. Do not use the size of the monitor image to judge the printed size.

Scanned images cannot be printed or come out garbled when printed

Try one or more of these solutions:

- Make sure this product is properly connected to the computer, correctly set up, and maintained.

- Check that your software is properly installed and set up for this product (see your Setup Sheet).

Images cannot be located properly in the Thumbnail preview

Try one or more of these solutions:

- In the Preview window, create marquees on the area you want to scan, and then scan.

- In the Configuration dialog, adjust the thumbnail cropping area using the Thumbnail Cropping Area slider.
Troubleshooting / Scanning Problems

Color Matching Problems

- Colors on your monitor are different from those in the original image
- Colors differ from the original
- Printed colors are different from those in the original image

Colors on your monitor are different from those in the original image

Exact color matching is very difficult. Check your software and monitor documentation for information on color matching and calibration. Also try one or more of these solutions:

- Check the image settings of your scanner software, especially data format (bits, pixel, color), gamma correction, and color correction. Try different combinations of these settings.

- Check the color matching and color management capabilities of your computer, display adapter, and software. Some computers can change the color palette to adjust the colors on your screen. See your software and hardware manuals for details.

- Use the color management system for your computer: ICM for Windows, or ColorSync for Macintosh. For Windows, add a color profile that matches your monitor.

[Top]

Colors differ from the original

Printed colors do not exactly match the colors on your monitor, since printers and monitors use different color systems: monitors use RGB (red, green, and blue), while printers typically use CMYK (cyan, magenta, yellow, and black). Try one or more of these solutions:

- Change the Display Gamma setting of the scanning image for your output device, such as monitor or printer, in the Configuration dialog box.

- Change the Image Type setting. See online help to make sure your settings are correct.
Printed colors are different from those in the original image

Exact color matching is very difficult. Check your software or contact your printer company for information on color matching and calibration.
Technical Support Web Site

Epson's Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting information in your printer documentation. If you have a Web browser and can connect to the Internet, access the site at:

http://www.latin.epson.com
Contacting Customer Support

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below:

From the Internet, you can reach Epson Support at http://www.latin.epson.com/. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.

Select your country:

<table>
<thead>
<tr>
<th>Argentina</th>
<th>Chile</th>
<th>Costa Rica</th>
<th>Peru</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brasil</td>
<td>Colombia</td>
<td>México</td>
<td>Venezuela</td>
</tr>
</tbody>
</table>

Argentina

EPSON ARGENTINA S.A.

Avenida Belgrano 964/970

(1092), Buenos Aires

Tel.: (54 11) 4346-0300

Fax: (54 11) 4346-0333

http://www.epson.com.ar
Brasil

EPSON DO BRASIL LTDA.

Av. Tucunaré, 720 Tamboré Barueri,

São Paulo, SP 06460-020

Tel.: (55 11) 7296-6100

Fax: (55 11) 7295-5624

http://www.epson.com.br

Chile

EPSON CHILE, S.A.

La Concepción 322

Providencia, Santiago

Tel.: (56 2) 236-2453

Fax: (56 2) 236-6524

http://www.epson.cl

Colombia

EPSON COLOMBIA, LTDA.

Diagonal 109 No. 15-49

Bogotá, Colombia

Tel.: (57 1) 523-5000

Fax: (57 1) 523-4180
http://www.epson.com.co

Costa Rica

EPSON COSTA RICA, S.A
Embajada Americana, 200 Sur y 300 Oeste
San José, Costa Rica
Tel.: (50 6) 296-6222
Fax: (50 6) 296-6046

http://www.epsoncr.com

México

EPSON MÉXICO, S.A. de C.V.
Av. Sonora #150
México, 06100, DF
Tel.: (52 5) 211-1736
Fax: (52 5) 533-1177

http://www.epson.com.mx

Perú

EPSON PERÚ, S.A.
Av. Del Parque Sur #400
San Isidro, Lima, Perú
Tel.: (51 1) 224-2336
Fax: (51 1) 476-4049

http://www.epson.com

Venezuela

EPSON VENEZUELA, S.A.

Calle 4 con Calle 11-1

La Urbina Sur Caracas, Venezuela

Tel.: (58 2) 240-1111

Fax: (58 2) 240-1128

http://www.epson.com.ve

Toll or long distance charges may apply.

Before you call, please have the following information ready:

- Product name (Epson Stylus CX4600)
- Product serial number (located on the back)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the Epson Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

If you need help with other software that came with your CX4600, see the following table:

<table>
<thead>
<tr>
<th>Software</th>
<th>Telephone</th>
<th>Fax</th>
<th>Online and E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EPSON Smart Panel</td>
<td>(510) 445-8616</td>
<td>(510) 445-8601</td>
<td><a href="http://www.newsoftinc.com/contactus@newsoftinc.com">www.newsoftinc.com/contactus@newsoftinc.com</a></td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>ArcSoft®PhotoImpression™</td>
<td>(510) 440-9901 8:30 AM-5:30 PM, Pacific Time, Monday through Friday</td>
<td>(510) 440-1270</td>
<td><a href="http://www.arcsoft.com/techmain/support@arcsoft.com">www.arcsoft.com/techmain/support@arcsoft.com</a></td>
</tr>
</tbody>
</table>
Loading Memory Cards

Loadable memory card

Available image files

Inserting a memory card into the slot

Ejecting memory cards

Loadable memory card

This product features three memory card slots.

![Memory card slots](image)

The types of memory cards you can insert in each slot are shown below.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Memory Stick/MagicGate Memory Stick/Memory Stick Duo*/Memory Stick Pro/Memory Stick Pro Duo*/SD Card/miniSD Card*/MultiMediaCard</td>
</tr>
<tr>
<td>b</td>
<td>SmartMedia/xD-Picture Card</td>
</tr>
<tr>
<td>c</td>
<td>CompactFlash/Microdrive</td>
</tr>
</tbody>
</table>

* An adapter is required.
Available image files

You can use image files that meet the following requirements.

<table>
<thead>
<tr>
<th>Media format</th>
<th>DCF version 1.0 compliant*</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>JPEG format image files**, DOS FAT (FAT 12 or 16, one partition) taken with a DCF version 1.0 compliant digital camera.</td>
</tr>
<tr>
<td>Image size</td>
<td>Vertical 120 to 4600 pixels, horizontal 120 to 4600 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 999</td>
</tr>
</tbody>
</table>

* DCF stands for the "Design rule for Camera File system" standard, which is set by the Japan Electronics and Information Technology Industries Association (JEITA).

** Supports Exif Version 2.1/2.2.

Note:

You cannot print images with file name containing double-byte characters.

Inserting a memory card into the slot

1. Press the On button to turn on this product.
2. Open the memory card slot cover.
3 Make sure the memory card light beside the memory card slot is off, and then insert a memory card as far as it can go into the appropriate slot.

Note:
You can load only one memory card at a time.

4 Close the memory card slot cover.
Caution:

- Do not try to force the memory card into the slot. Part of it will stick out.
- Incorrect loading of a memory card may damage this product, memory card, or both.
- Keep the memory card slot cover closed while a memory card is inserted. This protects the memory card and the slot from dust and static; otherwise data on the memory card may be lost, or this product may be damaged.
- Depending on the memory card inserted in this product, the static charge on the memory card may cause this product to malfunction.

Note:

If the memory card is inserted incorrectly, the memory card light does not go on.

Ejecting memory cards

1. Make sure that all print jobs have finished and that both the memory card access light and the On light are not flashing.

2. Open the memory card slot cover.

3. Make sure that the product is not accessing the memory card (the memory card slot light is not flashing), then pull the memory card straight out of the slot.

Caution:
- Do not remove the memory card or turn off the product while the printing or while the memory card access light or On light is flashing. Data on the memory card may be lost.

- If you are using this product with a computer which has Windows 2000 or XP installed, never turn this product off or disconnect the USB cable with a memory card inserted in this product; this may destroy data on the memory card. See Disconnecting or Turning Off This Unit for details.
Copying Files to Your Computer

Precautions on copying files

- For Windows Me and 98, the memory card driver must be installed. The memory card driver is automatically installed when you install the printer software for the first time.

- For Windows Me and 98, you cannot scan disk over a memory card inserted in this product.

Copying files to your computer

1. Make sure this product's is on, with a memory card inserted. Connect this product and your computer with USB cable.

2. **For Windows XP users:**
   Click **Start** and then select **My Computer**.

   **For Windows Me, 98 and 2000 users:**
   Double-click the My Computer icon on your desktop.

3. Double-click the removable disk icon and the folder where your image files are saved.

Note:
● If you have set the volume label, it is displayed as a drive name. If you have not set the volume label, the removable disk is displayed as a drive name.

● Be sure the memory card is inserted correctly, otherwise an error message will appear. If this happens, click Cancel and then insert the memory card correctly.

Select an image file and drag it to the folder you want to transfer to.
Saving Files to a Memory Card

外出 Precautions on saving files
外出 Saving files to your computer

This section explains how to save image files from your computer to a memory card inserted in the built-in card slot.

Precautions on saving files

● For Windows Me and 98, the memory card driver must be installed. The Memory card driver is automatically installed when you install the printer software for the first time.

● For Windows Me and 98, you can not scan when a memory card inserted in this product.

● Make sure the write protection of the memory card is off and the memory card is writable.

Saving files to your computer

1 Make sure this product's is on, with a memory card inserted. Connect this product and your computer with USB cable.

2 Windows XP:
Click Start and then select My Computer.

Windows Me, 98 and 2000:
Double-click the My Computer icon on your desktop.

3 Double-click the removable disk icon and the folder where you want to save image files.
Note:

- If you have set the volume label, it displayed as a drive name. If you have not set the volume label, the removable disk is displayed as a drive name.

- Be sure the memory card is inserted correctly, otherwise an error message will appear. If this happens, click **Cancel** and then insert the memory card correctly.

Select an image file and drag it to the folder you want to save to.
Disconnected or Turning Off This Unit

For Windows XP
For Windows 2000
For Windows Me/98
For Macintosh

Follow the steps below to turn off this product or disconnect this product from your computer.

Caution:

When you finish using a memory card in your CX4500 with your computer, be sure to remove it and turn off and disconnect this product properly following the steps in the appropriate sections below.

For Windows XP

1. Double-click the icon on the task bar.

2. Select USB Mass Storage Device and click Stop.

3. Select USB Mass Storage Device and click OK.

4. Click anywhere on the dialog box.

5. Remove the USB cable, if necessary.
Turn off this product.

**For Windows 2000**

1. Make sure that the both memory card access light and On light are not flashing.

2. Turn off your computer.

3. Remove the USB cable, if necessary.

4. Turn off this product.

**Note:**

If you turn off this product or disconnect the USB cable before turning off your computer, the "Problem Ejecting USB Mass Storage Device" window may appear.

**For Windows Me/98**

1. Double-click the **My Computer** icon on the desktop.

2. Right-click the **Removable Disk** icon, and then click **Eject.**
Remove the USB cable, if necessary.

Turn off this product.

For Macintosh

On the desktop, move the removable disk icon into the Trash.

Remove the USB cable, if necessary.

Turn off this product.
Using this product

Refer to the appropriate section below for the minimum and recommended computer system requirements necessary to use this product.

For Windows

To connect this product to a USB port, you need a Microsoft® Windows® Millennium Edition, Windows 98, Windows XP, or Windows 2000 pre-installed PC equipped with a USB port and this product must be connected via a standard, shielded USB cable.

Your computer should also meet the following system requirements.

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Me</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows 98</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows XP</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>Pentium 233 MHz</td>
<td>Pentium 300 MHz</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows Me</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows 98</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows XP</td>
<td>128 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>64 MB</td>
<td>256 MB</td>
</tr>
</tbody>
</table>
### HDD Space

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Me</td>
<td>40 MB</td>
<td>800 MB</td>
</tr>
<tr>
<td>Windows 98</td>
<td>40 MB</td>
<td>800 MB</td>
</tr>
<tr>
<td>Windows XP</td>
<td>70 MB</td>
<td>800 MB</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>70 MB</td>
<td>800 MB</td>
</tr>
</tbody>
</table>

| Others           | SVGA monitor (800 x 600) | XGA or better monitor (1024 x 768) |

**Note:**
For EPSON Smart Panel, Windows 98 in the above table means Windows 98 Second Edition or later.

Your computer dealer can help you update your system if it does not meet these requirements.

### For Macintosh

Your Macintosh must also meet the following system requirements.

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>64 MB</td>
<td>256 MB</td>
</tr>
<tr>
<td>50 MB</td>
<td>1.0 GB</td>
</tr>
</tbody>
</table>

**For Macintosh**

Operating System: Mac OS 9.1 or later

CPU: PowerPC G3 233 MHz

RAM: 64 MB

HDD Space: 50 MB

Operating System: Mac OS 9.1 or later

CPU: PowerPC G4 355 MHz

RAM: 256 MB

HDD Space: 1.0 GB
<table>
<thead>
<tr>
<th>Operating System</th>
<th>Mac OS X 10.2</th>
<th>Mac OS X 10.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>PowerPC G3 233 MHz</td>
<td>PowerPC G4 355 MHz</td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB RAM</td>
<td>256 MB RAM</td>
</tr>
<tr>
<td>HDD Space</td>
<td>50 MB</td>
<td>2.5 GB</td>
</tr>
</tbody>
</table>

**Note:**

- For Mac OS 9, the amount of available memory varies according to the number and kind of applications that are open. To see how much memory is available, choose **About This Computer** from the Apple menu, and refer to the memory size (listed in kilobytes) under "Largest Unused Block" (1,024K=1 MB).

- For Mac OS X, to see how much memory is available, choose **About This Mac** from the Apple menu.

- For Mac OS 9, the memory requirements above are for printing on Letter size paper. These requirements may vary depending on the size of the paper, the type of application you are using, and the complexity of the document that you want to print.

In addition to these system and memory requirements, you need 20 MB of free hard disk space to install your printer software. To print, you also need extra hard disk space amounting to about twice the size of the file that you want to print.
# Printing

<table>
<thead>
<tr>
<th>Printing method</th>
<th>On-demand ink jet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nozzle configuration</td>
<td>Monochrome (black) 90 nozzles</td>
</tr>
<tr>
<td></td>
<td>Color (cyan, magenta, yellow) 270 nozzles (90 [each color] x 3)</td>
</tr>
<tr>
<td>Print direction</td>
<td>Bidirectional with logic seeking</td>
</tr>
<tr>
<td>Input buffer</td>
<td>32 KB</td>
</tr>
</tbody>
</table>

[Top]
## Scanning

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scanner type</strong></td>
<td>Flatbed color image scanner</td>
</tr>
<tr>
<td><strong>Photoelectric device</strong></td>
<td>CIS</td>
</tr>
<tr>
<td><strong>Effective pixels</strong></td>
<td>5,100 x 7,020 pixels at 600 dpi, 100%</td>
</tr>
<tr>
<td><strong>Document size</strong></td>
<td>8.5 x 11.7&quot; (216 x 297 mm), A4, or US letter size (The reading area can be specified from your software.)</td>
</tr>
</tbody>
</table>
| **Scanning resolution** | 600 dpi (main scan)  
1200 dpi with Micro Step (sub scan)                                                |
| **Output resolution**  | 50 to 4800 dpi, 7200 dpi, and 9600dpi (in 1 dpi increments)                      |
| **Image data**         | 16 bits per pixel per color internal  
1 to 8 bits per pixel per color external                                             |
| **Gamma correction**   | User defined 2 level                                                             |
| **Interface**          | USB 1.1                                                                           |
| **Light source**       | RGB Three Color LED                                                              |
| **Reliability**        | 30,000 cycles of carriage movements (main unit MCBF)                              |
Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.

**Paper specifications**

**Single sheets:**

<table>
<thead>
<tr>
<th>Size</th>
<th>A4* (210 x 297 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A5 (148 x 210 mm)</td>
</tr>
<tr>
<td></td>
<td>Letter (216 x 279 mm)</td>
</tr>
<tr>
<td></td>
<td>Half-letter (140 x 216 mm)</td>
</tr>
<tr>
<td></td>
<td>Legal (216 x 356 mm)</td>
</tr>
<tr>
<td></td>
<td>Executive (184.2 x 267 mm)</td>
</tr>
<tr>
<td></td>
<td>A6 (105 x 148 mm)</td>
</tr>
<tr>
<td></td>
<td>B5 (182 x 257 mm)</td>
</tr>
<tr>
<td></td>
<td>5 x 8&quot; (127 x 203 mm)</td>
</tr>
<tr>
<td></td>
<td>8 x 10&quot; (203 x 254 mm)</td>
</tr>
<tr>
<td></td>
<td>Custom paper (89 to 216 mm x 89 to 1117 mm)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Plain bond paper, special paper distributed by Epson</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness (for plain bond paper)</td>
<td>0.08 to 0.11 mm (0.003 to 0.004 inch)</td>
</tr>
<tr>
<td>Thickness (for photo paper)</td>
<td>0.21 mm (0.008 inch)</td>
</tr>
<tr>
<td>Weight (for plain bond paper)</td>
<td>64 g/m² (17 lb) to 90 g/m² (24 lb)</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Weight (for photo paper)</td>
<td>206 g/m² (55 lb)</td>
</tr>
</tbody>
</table>

* You can only select A4 and 10 x 15 cm, or Letter and 4 x 6” from the control panel. The paper size that you can select may vary in certain locations.

**Envelopes:**

<table>
<thead>
<tr>
<th>Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>No. 10 (105 x 241 mm)</td>
<td></td>
</tr>
<tr>
<td>DL (110 x 220 mm)</td>
<td></td>
</tr>
<tr>
<td>C6 (114 x 162 mm)</td>
<td></td>
</tr>
<tr>
<td>220 x 132 (132 x 220 mm)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Plain bond paper, air mail, craft paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>0.16 to 0.52 mm (0.006 to 0.02 inch)</td>
</tr>
<tr>
<td>Weight</td>
<td>45 g/m² (12 lb) to 100 g/m² (27 lb)</td>
</tr>
</tbody>
</table>

**Premium Ink Jet Plain Paper:**

<table>
<thead>
<tr>
<th>Size</th>
<th>A4 (210 x 297 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**Bright White Ink Jet Paper:**

<table>
<thead>
<tr>
<th>Size</th>
<th>A4 (210 x 297 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------</td>
</tr>
</tbody>
</table>

**Matte Paper - HeavyWeight:**

| Size | A4 (210 x 297 mm)  
|      | Letter (216 x 279 mm)  
|      | 8 x 10” (203 x 254 mm) |

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Special paper distributed by Epson</th>
</tr>
</thead>
</table>

**Double-Sided Matte Paper:**

| Size | A4 (210 x 297 mm)  
|      | Letter (216 x 279 mm) |

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Special paper distributed by Epson</th>
</tr>
</thead>
</table>

**Archival Matte Paper:**

| Size | A4 (210 x 297 mm) |

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Special paper distributed by Epson</th>
</tr>
</thead>
</table>

**Photo Quality Ink Jet Paper:**

| Size | A4 (210 x 297 mm) |

<table>
<thead>
<tr>
<th>Paper types</th>
<th>Special paper distributed by Epson</th>
</tr>
</thead>
</table>

**Photo Quality Ink Jet Cards:**
| Size                     | A6 (105 x 148 mm)  
|                        | 5 × 8" (127 x 203 mm)  
|                        | 8 × 10" (203 x 254 mm)  
| Paper types            | Plain bond paper, air mail  

**DURABrite Photo Paper:**

| Size                     | A4 (210 x 297 mm)  
|                        | 4" x 6" (101.6 x 152.4 mm)  
| Paper types            | Special paper distributed by Epson  

**DURABrite Ink Glossy Photo Paper:**

| Size                     | Letter (216 x 279 mm)  
|                        | 4" x 6" (101.6 x 152.4 mm)  
| Paper types            | Special paper distributed by Epson  

**Photo Paper:**

| Size                     | A4 (210 x 297 mm)  
|                        | Letter (216 x 279 mm)  
|                        | 4 x 6" (113.6 x 175.4 mm)  
| Paper types            | Special paper distributed by Epson  

**Glossy Photo Paper:**
<table>
<thead>
<tr>
<th>Size</th>
<th>Letter (216 x 279 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 x 6&quot; (113.6 x 175.4 mm)</td>
</tr>
<tr>
<td>Paper types</td>
<td>Special paper distributed by Epson</td>
</tr>
</tbody>
</table>

**Note:**

- Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch to a higher grade paper.

- Do not load curled or folded paper.

- Use paper under normal conditions:
  - Temperature 15 to 25°C (59 to 77°F)
  - Humidity 40 to 60% RH

---

**Printable area**

Refer to the appropriate section below for the printable area of single sheets and envelopes with the standard borders.

| Single sheets | Envelopes |
The diagonal lines indicates the printable area.

<table>
<thead>
<tr>
<th></th>
<th>Single sheets</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A: top margin</td>
<td>3.0 mm (0.12&quot;)</td>
<td>3.0 mm (0.12&quot;)</td>
</tr>
<tr>
<td>B-L: left margin</td>
<td>3.0 mm (0.12&quot;)</td>
<td>5.0 mm (0.2&quot;)</td>
</tr>
<tr>
<td>B-R: right margin</td>
<td>3.0 mm (0.12&quot;)</td>
<td>5.0 mm (0.2&quot;)</td>
</tr>
<tr>
<td>C: bottom margin</td>
<td>3.0 mm (0.12&quot;)</td>
<td>20.0 mm (0.78&quot;)</td>
</tr>
</tbody>
</table>

**Note:**

Depending on the type of media being used, the print quality may deteriorate in the top and bottom areas of the printout, or these areas may be smeared.
## Built-in card slots

<table>
<thead>
<tr>
<th>Card Slots</th>
<th>CF Type II card slot</th>
<th>SmartMedia card slot</th>
<th>Memory Stick/Memory Stick PRO card slot</th>
<th>SD/MMC card slot</th>
<th>xD-Picture card slot</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Compatible with &quot;CF+ and CompactFlash Specification Revision 1.4&quot;</td>
<td>Compatible with &quot;SmartMedia Standard 2000&quot;</td>
<td>Compatible with &quot;Memory Stick Standard version 1.3&quot; and &quot;Memory Stick Standard Memory Stick PRO FORMAT Specifications version 1.0&quot;</td>
<td>Compatible with &quot;SD Memory Card Specifications/PART1. Physical Layer Specification Version 1.0&quot;</td>
<td>Compatible with &quot;xD-Picture Card™ card specification Version 1.0&quot;</td>
</tr>
<tr>
<td>Compatible memory cards</td>
<td>CompactFlash</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SmartMedia*</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MagicGate Memory Stick</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick Duo**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick PRO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Stick PRO Duo**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microdrive</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital) Card</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MiniSD Card**</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MultiMediaCard</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>xD-Picture Card</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voltage Requirements</th>
<th>3.3 v/5 v, 3.3 v</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Maximum current is 500 mA</td>
</tr>
</tbody>
</table>

* Maximum capacity is 128MB.
** Adapter required.
# Ink Cartridges

<table>
<thead>
<tr>
<th>Color</th>
<th>Black, Cyan, Magenta, Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cartridge life</strong></td>
<td>Within 6 months of opening the package, at 25°C [77°F]</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Storage:</td>
<td></td>
</tr>
<tr>
<td>-20 to 40°C (-4 to 104°F)</td>
<td></td>
</tr>
<tr>
<td>1 month at 40°C (104°F)</td>
<td></td>
</tr>
<tr>
<td>Transit:</td>
<td></td>
</tr>
<tr>
<td>-30 to 50°C (-22 to 122°F)</td>
<td></td>
</tr>
<tr>
<td>10 days at 50°C (122°F)</td>
<td></td>
</tr>
<tr>
<td>Freezing:*</td>
<td></td>
</tr>
<tr>
<td>-16°C (3.2°F)</td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>12.7 mm (W) x 73.5 mm (D) x 55.3 mm (H)</td>
<td></td>
</tr>
</tbody>
</table>

* Ink thaws and is usable after approximately 3 hours at 25°C (77°F).

---

**Caution:**

- Epson recommends the use of original Epson ink cartridges only. Products not manufactured by Epson may cause damage to your product and will not be covered by Epson's warranties.

- Do not use an ink cartridge if the date on the package has expired.
Do not refill the ink cartridge. This product calculates the amount of ink remaining using an IC chip on the ink cartridge, so even if the cartridge is refilled, the IC chip will report that it is empty.
## Mechanical

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper path</strong></td>
<td>Top feed, with one ASF</td>
</tr>
<tr>
<td><strong>Sheet feeder capacity</strong></td>
<td>About 100 sheets at 64 g/m² (17 lb) paper</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>430 mm x 344 mm x 170 mm (W x D x H, not including loading tray) (16.9 x 13.5 x 6.7 inches)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>6.6 kg (14.6 lb) without ink cartridges</td>
</tr>
</tbody>
</table>
# Electrical

- **100-120V Model**
  - Input voltage range: 90 to 132 V
  - Rated frequency range: 50 to 60 Hz
  - Input frequency range: 49.5 to 60.5 Hz
  - Rated current: 0.4 A (Max. 0.6 A)
  - Power consumption: Approx. 11 W (Standalone copying ISO10561 Letter pattern), Approx. 2.5 W in sleep mode, Approx. 0.2 W in power-off mode

- **220-240V Model**
  - Input voltage range: 198 to 240 V
  - Rated frequency range: 50 to 60 Hz
<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.2 A (Max. 0.3 A)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Approx. 11 W (Standalone copying ISO10561 Letter pattern)</td>
</tr>
<tr>
<td></td>
<td>Approx. 2.5 W in sleep mode</td>
</tr>
<tr>
<td></td>
<td>Approx. 0.4 W in power-off mode</td>
</tr>
</tbody>
</table>

**Note:**
Check the label on the back of this product for the voltage information.
## Environmental

| Temperature          | Operation: 10 to 35°C (50 to 95°F)  
|                      | Storage: -20 to 60°C (-4 to 140°F)  
|                      | 1 month at 40°C (104°F)  
|                      | 120 hours at 60°C (140°F)  
| Humidity            | Operation: 20 to 80% RH  
|                      | Storage: *,** 5 to 85% RH  

* Stored in shipping container  
** Without condensation
## Standards and Approvals

| Safety          | UL 60950  
|                | CSA 22.2 No.60950 |
| EMC            | FCC part 15 Subpart B class B  
|                | CSA C108.8 Class B |
Make a test print of this page to compare the printout of the two images below with the images on the previous page. Before printing, make sure paper is loaded and the printer is on.

Follow the steps below to print a test page:

1. Click **Print** on the File menu of the browser you are currently using.

2. Make sure that your printer is selected as the default printer, and click **OK** or **Print**.

3. Make sure the test print illustration on the printout prints properly.

4. Click **Back** to go back to the previous page.